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Introduction

This guide begins with a high-level overview of Real-Time Workshop®,
describing its purpose, its components, its major features, and the ways in
which it leverages the modeling power of Simulink® for developing real-time
applications on a variety of platforms. You will also find information about
installing Real-Time Workshop, including discussions of related products from
The MathWorks and compilers from third parties, as well as pointers to demos
and online and printable documentation. The chapter is laid out as follows:

What Is Real-Time Workshop? What it is, and what it can do for you
(p. 1-2)

Installing Real-Time Workshop Information on supported compilers
(p. 1-11)

Real-Time Workshop Demos (p. 1-16) Demonstrations that illustrate code
generation capabilities

MathWorks Products Supported by = Products for which code can be

Real-Time Workshop (p. 1-17) generated or which otherwise work
with Real-Time Workshop
Help and Documentation (p. 1-19) Locating and using online and

printed help documents
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What Is Real-Time Workshop?

¢ “Introduction” on page 1-2
* “Components and Features” on page 1-4

e “Accelerating Your Development Process” on page 1-7

Introduction

Real-Time Workshop® is an extension of capabilities of Simulink® and
MATLAB® that automatically generates, packages, and compiles source code
from Simulink models to create real-time software applications on a variety of
systems. By providing a code generation environment for rapid prototyping
and deployment, Real-Time Workshop is the foundation for production code
generation capabilities. Along with other tools and components from The
MathWorks, Real-Time Workshop provides

® Automatic code generation tailored for a variety of target platforms
® A rapid and direct path from system design to implementation

e Seamless integration with MATLAB and Simulink

® A simple graphical user interface

® An open architecture and extensible make process

The process of generating source code from Simulink models using Real-Time
Workshop is shown in the following diagram.
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Components and Features
The principal components and features of Real-Time Workshop are

¢ Simulink Code Generator — Automatically generates C code from your
Simulink model.

* Make process — The Real-Time Workshop user-extensible make process
lets you customize compilation and linking of generated code for your own
production or rapid prototyping target.

¢ Simulink external mode — External mode enables communication
between Simulink and a model executing on a real-time test environment,
or in another process on the same machine. External mode lets you perform
parameter tuning, data logging, and viewing using Simulink.

¢ Targeting support — Using the targets bundled with Real-Time
Workshop, you can build systems for real-time and prototyping
environments. The generic real-time and other bundled targets provide
a framework for developing customized rapid prototyping or production
target environments. In addition to the bundled targets, the optional
Real-Time Windows Target and the xPC Target let you turn almost
any PC into a rapid prototyping target or a small to medium volume
production target. To supplement core capabilities, the optional Real-Time
Workshop® Embedded Coder and embedded target (Target for xxxx)
products extend and tailor Real-Time Workshop code to run in a growing
suite of microprocessor environments.

¢ Rapid simulations — Using Simulink Accelerator, the S-Function Target,
or the Rapid Simulation Target, you can accelerate your simulations by
5 to 20 times on average. Executables built with these targets bypass
normal Simulink interpretive simulation mode. Code generated by
Simulink Accelerator, S-Function Target, and Rapid Simulation Target
is highly optimized to execute only the algorithms used in your specific
model. In addition, the code generator applies many optimizations, such as
eliminating ones and zeros in computations for filter blocks.

* Large-scale modeling — Support for multilevel modeling (termed model
referencing) in Simulink is mirrored in Real-Time Workshop, which lets you
generate code incrementally for a hierarchy of independent component
models, as they evolve.
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Features of Real-Time Workshop include

* Code generation for Simulink models

Generates optimized, customizable code. There are several styles of
generated code, which can be classified as either embedded (production
phase) or rapid prototyping.

Supports all Simulink features, including 8-, 16-, and 32-bit integers and
floating-point double and single data types.

Provides fixed-point capabilities for scaling of integer words ranging
from 1 (unsigned) or 2 (signed) to 32 bits. Code generation is limited

by the implementation of char, short, int, and long in embedded C
compiler environments (usually 8, 16, and 32 bits, respectively). You can
choose hardware characteristics for more than 20 preconfigured target
processors by name or create your own custom processor definition.

Generates processor-independent code. The generated code represents
your model exactly. A separate run-time interface is used to execute this
code. Real-Time Workshop provides several example run-time interfaces,
as well as production run-time interfaces.

Supports single- or multitasking operating system environments, as well
as bare-board (no operating system) environments.

Provides the flexible scripting capabilities of the Target Language
Compiler to enable you to fully customize generated code.

Allows you to craft efficient code for S-functions (user-created blocks)
using Target Language Compiler instructions (called TLC scripts) that
automatically integrates with generated code.

¢ Extensive model debugging support

External mode enables you to examine what the generated code is doing
by uploading data from your target to the graphical display elements in
your model. There is no need to use a conventional source-level debugger
to look at your generated code.

External mode also enables you to tune the generated code via your
Simulink model. When you change a parameter value of a block in your
model, the new value is passed down to the generated code running on
your target, and the corresponding target memory location is updated.
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Integration with Simulink

Code verification. You can generate code for your model and create a
stand-alone executable that exercises the generated code and produces a
MAT-file containing the execution results.

Generated code contains system and block identification tags to help you
identify the block in your source model that generated a given line of
code. The MATLAB command hilite_system recognizes these tags and
highlights the corresponding blocks in your model.

Support for Simulink data objects lets you define how your signals and
block parameters interface to the external world.

Integration with Stateflow®

Code generation. Seamless code generation support for models that
contain Stateflow charts.

Full support for Stateflow Coder features.

Rapid simulation

Real-Time Workshop supports several ways to speed up your simulations
by creating optimized, model-specific executables.

Target support

Turnkey solutions for rapid prototyping substantially reduce design
cycles, allowing for fast turnaround of design iterations.

Bundled rapid prototyping example targets provide working code you can
modify and use quickly. For a complete list of bundled targets, with their
associated system target files and template makefiles, see “Choosing and
Configuring Your Target” in the Real-Time Workshop documentation.

The optional Real-Time Windows Target and xPC Target for PC-based
hardware from The MathWorks enable you to turn a PC with fast,
high-quality, low-cost hardware into a rapid prototyping system.

Real-Time Workshop Embedded Coder, an add-on product, provides
extensive support for tailoring generated code to special requirements
of embedded hardware, software environments, data formats, and tool
chain protocols.

The MathWorks offers a growing set of code generation products for
embedded processors, such as Target for Infineon C166® and Target for
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Freescale™ MPC5xx, which via turnkey hardware support extend the
benefits of Real-Time Workshop and Real-Time Workshop Embedded
Coder into production environments.

= Supports a variety of third-party hardware and tools, with extensible
device driver support.

¢ Extensible make process
= Allows for easy integration with any embedded compiler and linker.
= Provides for easy linkage with your hand-written supervisory or
supporting code.
Real-Time Workshop Embedded Coder, mentioned above,
¢ Generates ANSI/ISO C code and executables for discrete, continuous, or
hybrid models

® Uses model blocks to incrementally generate and build code for large
applications

® Supports Simulink data dictionary features for integer, floating-point, and
fixed-point data

® Generates code for single-rate, multirate, and asynchronous models

® Supports single-tasking and multitasking operating systems and
bare-board (no operating system) environments

® Performs code optimizations that improve code execution speed
® Provides capabilities for code customization and legacy code integration

® Lets you interactively tune and monitor the generated code inside or
outside of Simulink

Accelerating Your Development Process

The MathWorks gives you the ability to simplify and accelerate most phases
of software development, and at the same time to eliminate repetitive and
error-prone tasks, including some design document preparation. These tools
lend themselves particularly well to the spiral design process shown below.



Introduction

\ /
\ /
#’ System-level /
\ design /
Detailed \ /
design \ /
A / Problem/task
\ / formulation
\ /
\ /

A NEmNsH

/ \ START

:/ \
Software /, \\ Production and
and hardware / \ manufacturing
implementation / \ festing
/ \
/ \
/ Design \
/  viatesting \
DESIGN

INTEGRATION

SOFTWARE IMPLEMENTATION

When you work with tools from The MathWorks, your model represents your
understanding of your system. This understanding is preserved from one
phase of modeling to the next, reducing the need to backtrack. In the event
that rework is necessary in a previous phase, it is easier to step back because
the same model and tools are used throughout.

A spiral design process allows quick iterations between phases, enabling you
to focus on design work. To do this cost-effectively, you need to use tools that
make it easy to move from one phase to another. For example, in a matter

of minutes a control system engineer or a signal processing engineer can
verify that an algorithm works on a real-world rapid prototyping system. The
spiral process lends itself naturally to parallelism in the overall development
process. You can provide early working models to validation and production
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groups, involving them in your system development process from the start.
Once unit models are prototyped, tested, and ready, they can be packaged into
larger assemblies using Model blocks (the Simulink model referencing facility).
This helps to compress overall development time while increasing quality.

Simulink facilitates the first three phases described in the above figure. You
can build applications using built-in blocks from the Simulink and Stateflow
libraries, incorporate specialized blocks from the Aerospace Blockset,
Communications Blockset, Signal Processing Blockset, and other MathWorks
blocksets, and develop your own blocks by writing S-functions.

Real-Time Workshop (optionally extended by Real-Time Workshop Embedded
Coder, Real-Time Windows Target, and xPC Target) completes the spiral
process. It closes the rapid prototyping loop by generating and optimizing
code for given tasks and production environments.

The figure below illustrates where products from The MathWorks, including
Real-Time Workshop, help you in your development process.

Interactive design Interactive modeling and simulation High-speed simulation

Accelerator,
S-function Targets

MATLAB
and

Simulink
Stateflow
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Workshop

Toolboxes

Design

Cycle Embedded
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monitoring and
parameter funing,
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System testing and tuning
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Software integration
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Early in the design process, you use MATLAB and Simulink to help you
formulate your objectives, problems, and constraints to create your initial
design. Real-Time Workshop speeds up models by enabling high-speed
simulations via Simulink Accelerator and by model referencing, which
includes models in other models as blocks.

After you have a functional model, you might need to tune your model’s
parameters. You can do this quickly using the Real-Time Workshop Rapid
Simulation Target for Monte Carlo and other batch-oriented simulations
(varying coefficients over many simulations).

Once you have tuned your model, you can move into system development
testing by exercising your model on a rapid prototyping system, such as
Real-Time Windows Target or xPC Target. With a rapid prototyping target,
you connect your model to your physical system. This lets you locate design
flaws and modeling errors quickly.

After you create your prototype system and verify its outputs, you can use
Real-Time Workshop Embedded Coder to deploy generated code on your
custom target. The signal monitoring and parameter tuning capabilities
enable you to easily integrate the embedded code into a production
environment equipped with debugging and upgrade capabilities. See the
Real-Time Workshop Embedded Coder documentation for an overview of this
process. First, however, see “Real-Time Workshop Workflow” on page 2-2 for a
process view of using Real-Time Workshop.
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Installing Real-Time Workshop

¢ “Installation Requirements” on page 1-11
¢ “Supported Third-Party Compilers” on page 1-12
® “Compiler Optimization Settings” on page 1-12

¢ “Troubleshooting Third-Party Windows Compiler Configurations” on page
1-13

Installation Requirements

Your platform-specific MATLAB installation documentation provides all the
information you need to install Real-Time Workshop.

Before installing Real-Time Workshop, you must obtain a License File or
Personal License Password (PLP) from The MathWorks. The License File or
PLP identifies the products you are permitted to install and use.

If you customize your installation, the installer displays a dialog box that lets
you select the MATLAB products to install. You can select and install only
products for which you are licensed.

Simulink, Real-Time Workshop, and Real-Time Workshop Embedded Coder
each have product prerequisites for proper installation and execution
described in the following table.

Licensed Product

Prerequisite Products | Additional Information

MATLAB Allows installation of Simulink

Real-Time Workshop Simulink Requires Borland C, LCC, Visual

C/C++ Professional, or Watcom C
compiler to create MATLAB MEX-files
or other executables on your platform

Real-Time Workshop Real-Time Workshop —

Embedded Coder

If you experience installation difficulties and have Web access, use the
resources available on the MathWorks Web site Support page Installation and
Licensing section at http://www.mathworks.com/support/.

1-11
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Supported Third-Party Compilers

Most Real-Time Workshop targets create an executable that runs on your
workstation. When creating the executable, Real-Time Workshop must be able
to access an appropriate compiler. Real-Time Workshop can automatically
find a compiler to use based on your default MEX compiler.

For more about third party compilers, see “Choosing and Configuring
a Compiler” in the Real-Time Workshop documentation. For details on
supported compiler versions, see

http://www.mathworks.com/support/tech-notes/1600/1601.shtml

Compiler Optimization Settings

In some very rare instances, because of compiler defects, compiler
optimizations applied to Real-Time Workshop generated code can cause the
executable program to produce incorrect results, even though the code itself is
correct.

Real-Time Workshop uses the default optimization level for each supported
compiler. You can usually work around problems caused by compiler
optimizations by lowering the optimization level of the compiler or by turning
off optimizations. Refer to your compiler’s documentation for information

on how to do this.

Out-of-Environment Error Message

If you receive out-of-environment space error messages, right-click your
mouse on the program that is causing the problem (for example, dosprmpt or
autoexec.bat) and choose Properties. From there choose Memory. Set the
Initial Environment to the maximum allowed and click Apply. This should
increase the amount of environment space available.
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Troubleshooting Third-Party Windows Compiler
Configurations

This section provides compiler-specific configuration instructions. If you have
problems with Windows compiler configuration, first ensure that MATLAB
supports the compiler and version that you want to use. For a complete list of
supported compilers and versions, see

http://www.mathworks.com/support/tech-notes/1600/1601.shtml

Borland

Make sure that your Borland environment variable is defined and correctly
points to the directory in which your Borland compiler resides. To check this,

type

set BORLAND

at the DOS prompt. Check the return from this command to see whether the
BORLAND environment variable is defined and points to the Borland compiler.

If the BORLAND environment variable is not defined, you must define it to point
to where you installed your Borland compiler. Launch the System control

panel, select the Advanced tab, click Environment Variables, and define
BORLAND to be the path to your compiler.

Intel

The Intel compiler requires a compatible version of Microsoft Visual C/C++. A
version compatibility table appears at

http://www.intel.com/support/performancetools/c/windows/sb/CS-022504.htm
To set up the Intel compiler automatically,

1 Type mex -setup in the MATLAB Command Window.

2 Follow the instructions that appear, selecting the Intel compiler.

To set up the Intel compiler manually,

1-13
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1 Copy the file$ (MATLAB) \bin\win32\mexopts\intelc71opts.bat and
rename it mexopts.bat in your preferences directory (prefdir).

2 Edit the new mexopts.bat file and replace%sMSVCDir% with the root
directory of your Microsoft Visual C/C++ installation.

3 Replace %$INTELC71% with the root directory of the Intel compiler
installation.

Visual C/C++ provides a DOS Batch file that you must run in order to ensure
command-line access to Visual C/C++. On a 32-bit Windows machine with
Visual C/C++ 7.1 installed on the C: drive, the batch file is:

C:\Applications\Microsoft Visual Studio .NET 2003\Vc7\bin\vcvars32.bat

If your installation differs and you cannot find the correct batch file, consult
the Visual C/C++ documentation.

LCC

The freeware LCC C compiler is shipped with MATLAB, and is
installed with the product. If you want to use LCC to build programs
generated by Real-Time Workshop, use the version that is currently
shipped with the product. Information about LCC is available at
http://www.cs.virginia.edu/~1lcc-win32/.

Microsoft Visual C/C++
Use the MATLAB command

mex -setup

to define the environment for Visual C/C++. Note that only the Professional
version is supported.
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Watcom

The Watcom C compiler is no longer available from the manufacturer.
Development of this compiler has been taken over by the Open Watcom
organization (http://www.openwatcom.org), which has released a binary
patch update (11.0c) for existing Watcom C/C++ and Fortran customers.
Real-Time Workshop continues to ship with Watcom-related target
configurations. However, this policy may be subject to change in the future.

Make sure that your Watcom environment variable is defined and correctly
points to the directory in which your Watcom compiler resides. To check this,

type

set WATCOM

at the DOS prompt. Check the return from this command to see whether the
WATCOM environment variable is defined and points to the Watcom compiler.

If the WATCOM environment variable is not defined, you must define it to point
to where you installed your Watcom compiler. Launch the System control
panel, click the Advanced tab, click Environment Variables, and define
WATCOM to be the path to your compiler.

1-15
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Real-Time Workshop Demos

A good way to familiarize yourself with Real-Time Workshop is by browsing
through its suite of demos, running the ones of interest, and then inspecting
code generated from these demo models. The demos illustrate many (but not
all) Real-Time Workshop features.

To access the current set of demos for Real-Time Workshop, type

rtwdemos

at the MATLAB prompt. You can also find Real-Time Workshop demos by
navigating to Real-Time Workshop, (found under Simulink) in the Demos
pane of the Help browser.

Note that many of the Real-Time Workshop demos illustrate features of
Real-Time Workshop Embedded Coder, and are thus set up to generate code
for the ERT target. Should MATLAB find no license for Real-Time Workshop
Embedded Coder on your system, you can still run the demos, but all code
generated will default to the GRT target.
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MathWorks Products Supported by Real-Time Workshop

Many blocksets and other MathWorks products can work with Real-Time
Workshop. The following table lists products that Real-Time Workshop and
Real-Time Workshop Embedded Coder support.

Product Real-Time Workshop Real-Time Workshop
Support Embedded Coder Support

Aerospace Blockset Yes Yes

CDMA Reference Blockset Yes Yes

Communications Blockset Yes Yes

Control System Toolbox Yes Yes

Gauges Blockset Yes Yes

Fuzzy Logic Toolbox Yes Yes

Link for Code Composer Yes Yes

Studio™

Link for TASKING® Yes Yes

Model Predictive Control Yes Yes

Toolbox

Model-Based Calibration Yes Yes

Toolbox

Real-Time Windows Target Yes No

Signal Processing Blockset Yes Yes

Details: “Block Data
Type Support Table”in the
Signal Processing Blockset

Details: “Block Data
Type Support Table”in the
Signal Processing Blockset

documentation documentation
SimDriveLine Yes Yes
SimMechanics Yes Yes
SimPowerSystems Yes No

1-17
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Product Real-Time Workshop Real-Time Workshop
Support Embedded Coder Support
Simulink Yes Yes

Details: “Simulink Block
Support” Table in the
Real-Time Workshop

Details: “Simulink Block
Support” Table in the
Real-Time Workshop

documentation documentation

Simulink Fixed Point Yes Yes
Simulink Parameter Yes Yes
Estimation

Simulink Report Generator Yes Yes
Simulink Verification and Yes Yes
Validation

Stateflow and Stateflow Coder | Yes Yes
Target for Freescale™ Yes Yes
MPC5xx

Target for Infineon C166® Yes Yes
Target for TI C2000™ Yes Yes
Target for TT C6000™ Yes Yes
Video and Image Processing Yes Yes
Blockset

Virtual Reality Toolbox Yes Yes
xPC Target Yes Yes
xPC Target Embedded Option | Yes Yes
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Help and Documentation

® “Prerequisites” on page 1-19
¢ “Online Documentation” on page 1-19

¢ “For Further Information” on page 1-20

Prerequisites

Real-Time Workshop software is shipped with this Getting Started guide.
Users of this book should be familiar with

¢ Using Simulink and Stateflow to create models/machines as block
diagrams, running such simulations in Simulink, and interpreting output
in the MATLAB workspace

¢ High-level programming language concepts applied to real-time systems

While you do not need to program in C or other programming languages

to create, test, and deploy real-time systems using Real-Time Workshop,
successful emulation and deployment of real-time systems requires
familiarity with parameters and design constraints. The Real-Time Workshop
documentation assumes you have a basic understanding of real-time system
concepts, terminology, and environments. The documentation is available in
the following locations:

¢ Online at http://www.mathworks.com
¢ Through the MATLAB Help browser

¢ As PDF documents that you can view online or print

Online Documentation

Access to the online information for Real-Time Workshop is through MATLAB
or from the MathWorks Web site at http://www.mathworks.com/support/.
Click the Documentation link.
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To access the documentation with the MATLAB Help browser, use the
following procedure:

1 In the MATLAB window, click Help > Full product family help, or click
the ? icon on the toolbar.

The Help browser window opens.
2 In the left pane, click the Real-Time Workshop book icon.

The Help browser displays the Real-Time Workshop roadmap page in the
right pane. Click any link there, or click the + sign to the left of the book
icon in the left pane to reveal the table of contents. When you do so, the
+ changes to a -.

For Further Information

The Real-Time Workshop User’s Guide documents, in detail, the capabilities
of Real-Time Workshop. For a topical overview of its contents, see “How Do
I...” in the Real-Time Workshop documentation.

You can customize output from Real-Time Workshop at the block, target, and
makefile levels. For advanced uses, you might have to prepare or modify
Target Language Compiler files, as explained in the Target Language
Compiler documentation.



Building an Application

This chapter expands the high-level discussion of code generation and the
build process given in Chapter 1, “Introduction”. It provides a foundation of
understanding for tutorial exercises in Chapter 3, “Working with Real-Time

Workshop”.
Real-Time Workshop Workflow Explains the typical workflow for
(p. 2-2) applying Real-Time Workshop to the
application development process
Automatic Program Building Describes the flow of control for code
(p. 2-16) generation
Build Process (p. 2-18) Describes the sequence of events

that takes place when you click the
Build button, including the files that
the Target Language Compiler uses
and creates
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Real-Time Workshop Workflow

“Workflow Overview” on page 2-2

e “Mapping Application Requirements to Configuration Options” on page 2-3
® “Adjusting Configuration Settings” on page 2-8

¢ “Running Model Advisor” on page 2-9

® “Generating Code” on page 2-10

¢ “Building an Executable Program” on page 2-11

* “Verifying the Executable Program” on page 2-12

* “Naming and Saving the Configuration Set” on page 2-12

® “Documenting the Project” on page 2-14

Workflow Overview

The typical workflow for applying Real-Time Workshop to the application
development process involves the following steps:

1 Map your application requirements to available configuration options.

2 Adjust configuration options as necessary.

3 Run the Model Advisor Tool.

4 If necessary, tune configuration options based on the Model Advisor report.
5 Generate code for your model.

6 Repeat steps 2 to 5 if necessary.

7 Build an executable program image.

8 Verify that the generated program produces results that are equivalent
to those of your model simulation.

9 Save the configuration, and alternative ones with the model.

10 Use Simulink Report Generator to automatically document the project.
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The following figure shows these steps in a flow diagram. Sections following
the figure discuss the steps in more detail.

Map Application Requirements
to Configuration Options

A

Adjust Configuration Settings

A 4

Run Model Advisor

Configuration
Requires
Tuning?

No

Generate Code M

No
Code OK?

Yes

A

Build Executable Program

A\ 4
Verify Executable Program

Results Match
Simulation?

Name and Save P
Configuration Set

'

Document Project

Mapping Application Requirements to Configuration
Options
The first step in applying Real-Time Workshop to the application development

process is to consider how your application requirements, particularly
with respect to debugging, traceability, efficiency, and safety, map to code
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generation options available through the Simulink Configuration Parameters
dialog box. The following screen display shows the Real-Time Workshop
pane of the Configuration Parameters dialog box.

'gé.- Configuration Parameters: basic/Configuration (Active) 5[
Select r— T arget selection
Salver System target fe: [ort He Browse.
D ata Impart/E xport
Dptimization Language: I C =l
- Diagnostics Description: Generic Real Time Target
~Sample Time
~DataValidity —Documertation
~Type Conversion [ Generate HTHL report
~Connectiviy
Compatibiity IT Launch report automaticaly
~Model Referencing Build
- Hardware Implemertation [0
TLE options: |
Makefile configuratian
Sumbols [¥ Generate makefile
Custor Code Make command: [matee_itw
Debuig Template makefile: |g|l_default_tmf
Interface
[~ Generats code only Build
oK | LCancel | Help | Spply |

Parameters that you set in the various panes of the Configuration Parameters
dialog box affect the behavior of a model in simulation and the code generated
for the model. Real-Time Workshop automatically adjusts the available
configuration parameters and their default settings based on your target
selection. For example, the preceding dialog box display shows default
settings for the generic real-time (GRT) target. However, you should become
familiar with the various parameters and be prepared to adjust settings to
optimize a configuration for your application.

As you review the parameters, consider questions such as the following:

® What settings will help you debug your application?

® What is the highest priority for your application — traceability, efficiency,
extra safety precaution, or some other criterion?

e What is the second highest priority?

e (Can the priority at the start of the project differ from the priority required
for the end? What tradeoffs can be made?
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Mapping of Application Requirements to Configuration Parameters

Once you have answered these questions, review the following table,
which summarizes the impact of each configuration option on debugging,
traceability, efficiency, and safety considerations, and indicates the default
(factory) configuration settings for the GRT target. For additional details,

click the links in the Configuration Parameter column.

Note If you use a Real-Time Workshop Embedded Coder target, a specific
embedded target, a Stateflow target, or fixed-point blocks, you need to
consider the mapping of many other configuration parameters. For details,
see the Real-Time Workshop Embedded Coder documentation and any other
documentation specific to your target environment.

Configuration

Parameter Debugging| Traceability| Efficiency | Safety Default

Solver

Stop time No impact | Noimpact | No No impact 10.0 seconds
impact

Type No impact | Noimpact | No No impact Variable step
impact

Data Import/Export

Load from N/A N/A N/A N/A Clear

workspace

Save to Maybe Maybe Clear No impact Set

workspace

Save options Maybe Maybe No No impact Set
impact

Optimization

Block reduction | Clear Clear Set No impact Set
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Mapping of Application Requirements to Configuration Parameters (Continued)

Configuration
Parameter Debugging| Traceability| Efficiency | Safety Default

Implement No impact | No impact Set No impact Set
logic signals as
Boolean data

(versus double)

Inline Clear Set Set No impact Clear
parameters

Conditional No impact | Set Set No impact Set
input branch
execution

Signal storage Clear Clear Set No impact Set
reuse

Application No impact | No impact Finite inf inf
lifespan (days) value

Enable local Clear No impact Set No impact Set
block outputs

Ignore integer Clear No impact | Set Clear Clear
downcasts

in folded
expressions

Eliminate Clear No impact Set No impact Set
superfluous
temporary
variables
(Expression
folding)

Loop unrolling No impact | No impact >0 No impact 5
threshold

Reuse block Clear Clear Set No impact Set
outputs
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Mapping of Application Requirements to Configuration Parameters (Continued)

Configuration

Parameter Debugging| Traceability| Efficiency | Safety Default

Inline invariant | Clear Clear Set No impact Set

signals

Hardware Implementation

Number of bits No impact | No impact | Target No impact 8, 16, 32, 32
specific

Real-Time Workshop

Generate HTML | Set Set No No impact Clear

report impact

Real-Time Workshop: Comments

Include Set Set No No impact Set

comments impact

Simulink block Set Set No No impact Set

comments impact

Show eliminated | Set Set No No impact Clear

blocks impact

Verbose Set Set No No impact Clear

comments for impact

Simulink Global

storage class

Real-Time Workshop: Symbols

Maximum Set >30 No No impact 31

identifier length impact

Real-Time Workshop: Debug

Verbose builds Set No impact No Set Set
impact

Real-Time Workshop: Interface
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Mapping of Application Requirements to Configuration Parameters (Continued)

Configuration

Parameter Debugging| Traceability| Efficiency | Safety Default
Target floating No impact | No impact Set No impact ANSI-C
point math

environment

Utility function Shared Shared Shared No impact Auto*
generation

MAT-file variable | No impact | No impact No No impact rt_
name modifier impact

* Backward compatibility with previous release

Adjusting Configuration Settings

Once you have mapped your application requirements to appropriate
configuration parameter settings, adjust the settings accordingly. Using the
Default column in Mapping of Application Requirements to Configuration
Parameters on page 2-5, identify the configuration parameters you need

to modify. Then, open the Configuration Parameters dialog box or Model
Explorer and make the necessary adjustments.

Tutorials in Chapter 3, “Working with Real-Time Workshop” guide you
through exercises that modify configuration parameter settings. For details
on the configuration parameters that pertain to code generation, see “Code
Generation and the Build Process” in the Real-Time Workshop documentation.

Note In addition to using the Configuration Parameters dialog box, you can
use get_param and set_param to individually access most configuration
parameters both interactively and in scripts. The configuration parameters
you can get and set are listed in the “Configuration Parameter Reference” in
the Real-Time Workshop documentation.
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Running Model Advisor

Before you generate code, it is good practice to run the Model Advisor. Based
on a list of options you select, this tool analyzes your model and its parameter
settings, and generates a report that lists findings with advice on how to
correct and improve the model and its configuration.

One way of starting the Model Advisor is to select Tools > Model Advisor in
your model window. A new window appears listing specific diagnostics you
can selectively enable or disable. Some examples of the diagnostics follow:

¢ Identify blocks that generate expensive saturation and rounding code

® Check optimization settings

¢ Identify questionable software environment specifications

Although you can use the Model Advisor to improve model simulation, it
is particularly useful for identifying aspects of your model that limit code

efficiency or impede deployment of production code. The following figure
shows part of a sample report from Model Advisor.
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Model Advisor -- d:\work2\slprj\modeladvisor\rtwdemo_f14\report.htm - |EI|1|
A=A ]

| v

Model Advisor Report for 'twdemo_f14'
Model version: 1.33
Generated on: 16-Jan-2007 16:38:45

24 of 38 Passed

M Check model, local libraries, and referenced models for known upgrade issues

The Model Advisor has checked blocks, settings, and references in your model for issues in using it with
this version of Simulink. As a first step in resolving any issues described below, you should run the
Simulink update tool, slupdate, on models and libraries that have reported issues. Note that there could be
more issues beyond the ones identified here. See doc(slupdate’) for more information.

Referenced model update status:

* Passed - (No models referenced from this file need updating)
Library update status (only referenced blocks are checked):

* Passed - (No non-MathWaorks libraries are linked by this block diagram)
S-function update status for the Level 2 AP (see Writing S-Functions):

* Passed

Blocks rec ded for update, grouped by update reason:

H H

Update reason — set virtual outport initial condition (IC) parameter to [] (empty):

rtwdemo_f14/Aircraft Dynamics Model/Pitch Rate g (rad//sec)

Done

For more information on using the Model Advisor, see “Using the Model
Advisor” in the Real-Time Workshop documentation.

Generating Code

After fine-tuning your model and its parameter settings, you are ready to
generate code. Typically, the first time through the process of applying
Real-Time Workshop for an application, you want to generate code without
going on to compile and link it into an executable program. Some reasons
for doing this include the following:

* You want to inspect the generated code. Is Real-Time Workshop generating
what you expect?

® You need to integrate custom handwritten code.
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* You want to experiment with configuration option settings.

You specify code generation only by selecting the Generate code only
check box available on the Real-Time Workshop pane of the Configuration
Parameters dialog box (thus changing the label of the Build button to
Generate code). Real-Time Workshop responds by analyzing the block
diagram that represents your model, generating C code, and placing the
resulting files in a build directory within your current working directory.

After generating the code, inspect it. Is it what you expected? If not,
determine what model and configuration changes you need to make, rerun
the Model Advisor, and regenerate the code. When you are satisfied with the
generated code, build an executable program image, as explained in “Building
an Executable Program” on page 2-11.

For a more detailed discussion of the code generation process, see “Automatic
Program Building” on page 2-16 and “Build Process” on page 2-18. For
details on the Generate code only option, see “Generate Code Only” in the
Real-Time Workshop documentation.

Building an Executable Program

When you are satisfied with the code Real-Time Workshop generates for your
model, build an executable program image. If it is currently selected, you
need to clear the Generate code only option on the Real-Time Workshop
pane of the Configuration Parameters dialog box. This changes the label of
the Generate code button back to Build.

2-11
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One way of initiating a build is to click the Build button. Real-Time Workshop
responds by

1 Generating the C code, as explained in “Generating Code” on page 2-10.

2 Creating a customized makefile based on a template makefile for your
target of choice and placing the makefile in the build directory.

3 Instructing your system’s make utility to use the generated makefile to
compile the generated source code, link object files and libraries, and
generate an executable program file called model (UNIX) or model.exe
(Windows). The executable image resides in your working directory.

For a more detailed discussion of the build process, see “Automatic Program
Building” on page 2-16 and “Build Process” on page 2-18.

Verifying the Executable Program

Once you have an executable image, run the image and compare the results to
the results of your model’s simulation. You can do this by

1 Logging output data produced by simulation runs
2 Logging output data produced by executable program runs

3 Comparing the results of the simulation and executable program runs

Does the output match? Are you able to explain any differences? Do you need
to eliminate any differences? At this point, it might be necessary to revisit
and possibly fine-tune your block and configuration parameter settings.

For an example, see “Code Verification” on page 3-21.

Naming and Saving the Configuration Set

When you close a model, you should save it to preserve your configuration
settings (unless you regard your recent changes as dispensable). If you want
to maintain several alternative configurations for a model (e.g., GRT and
Rapid Simulation targets, inline parameters on/off, different solvers, etc.), you
can set up a configuration set for each set of configuration parameters and
give it an identifying name. You can do this easily in Model Explorer.
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To name and save a configuration,

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click the Configuration (active) node under the model name.
The Configuration Parameters dialog box appears in the right pane.

4 In the Configuration Parameters pane, type a name you want to give
the current configuration in the Name field.

5 Click Apply. The name of the active configuration in the Model
Hierarchy pane changes to the name you typed.

6 Save the model.

Adding and Copying Configuration Sets

You can save the model with more than one configuration so that you
can instantly reconfigure it at a later time. To do this, copy the active
configuration to a new one, or add a new one, then modify and name the

new configuration, as follows:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 To add a new configuration set, while the model is selected in the Model
Hierarchy pane, select Configuration Set from the Add menu, or click
the yellow gear icon on the toolbar:

%

A new configuration set named Configuration appears in the Model
Hierarchy pane.
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4 To copy an existing configuration set, right-click its name in the Model
Hierarchy pane and drag it to the + sign in front of the model name.

A new configuration set with a numeral (e.g., 1) appended to its name
appears lower in the Model Hierarchy pane.

5 If desired, rename the new configuration by right-clicking it, selecting
Properties, and typing the new name in the Name field on the
Configuration Parameters dialog box that appears. Then click the Apply
button.

6 Make the new configuration the active one by right-clicking it in the Model
Hierarchy pane and selecting Activate from the context menu.

The content of the Is Active field in the right pane changes from no to yes.

7 Save the model.

Documenting the Project

Consider documenting the design and implementation details of your project
to facilitate
® Project verification and validation

¢ Collaboration with other individuals or teams, particularly if dependencies
exist

¢ Archiving the project for future reference

One way of documenting a Real-Time Workshop code generation project is
to use the Report Generator for MATLAB and Simulink. Using the Report
Generator, you can generate a comprehensive Rich Text Format (RTF),
Extensible Markup Language (XML), or Hypertext Markup Language
(HTML) report that includes the following information:

® Model name and version

¢ Real-Time Workshop version

¢ Date and time Real-Time Workshop generated the code

¢ List of generated source and header (include) files
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¢ Optimization and Real-Time Workshop target selection and build process
configuration settings

® Mapping of subsystem numbers to subsystem labels

® Listings of generated and custom code for the model

To get started with generating a code generation report, see the demo
rtwdemo_codegenrpt and tutorial “Documenting a Code Generation Project”

on page 3-62. For details on using the Report Generator, see the MATLAB
Report Generator documentation.
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Automatic Program Building

Real-Time Workshop builds programs automatically for real-time applications
in a variety of host environments. Using the make utility, Real-Time Workshop
controls how it compiles and links the generated source code.

The following figure illustrates the complete process. The box labeled
“Automated build process” highlights portions of the process that Real-Time
Workshop executes.

/7 Simulink "\
model
User-developed | s Your
model and 4 ) Template
template — Makefile
makefile Configuration
\ Set Parameters/ system.tmf
Generate Generate -make_rtw.m
Code Makefile
\4 \4
Automated Model Code Custom
build process | model . c Makefile
model .h model .mk
model private.h
(make - model. mk)
J G
Executable i
C program Program
L model.exe




Automatic Program Building

The M-file specified by the Make command field in the Build process
section of the Real-Time Workshop pane of the Configuration Parameters
dialog box controls an internal portion of the Real-Time Workshop build
process. By default, the name of the M-file command is make_rtw; Real-Time
Workshop will invoke this M-file for most targets. Any options specified in
this field will be passed into the makefile-based build process. In some cases,
targets will customize the make rtw command. However, the arguments used
by the function must be preserved.

Although the command may work for a stand-alone model, use of the
make_rtw command at the command line can be error prone. For example, if
you have multiple models open, you need to make sure the current subsystem,
found by entering gcs in the MATLAB command window, contains the model
you want to build. Also, some target environments supply a Make command
in the Configuration Parameters dialog box that is not make_rtw. Finally,
models containing Model blocks do not build by using make_rtw directly.

To build (or generate code for) a model as currently configured from the
MATLAB Command Window, use one of the following rtwbuild commands.

rtwbuild modelname
rtwbuild( 'modelname')
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e “Build Process Steps” on page 2-18

e “Model Compilation” on page 2-20

® “Code Generation” on page 2-20

e “Customized Makefile Generation” on page 2-21
e “Executable Program Generation” on page 2-22

¢ “Files and Directories Created by the Build Process” on page 2-23

Build Process Steps

Real-Time Workshop generates C code only or generates the C code and
produces an executable image, depending on the level of processing you
choose. By default, a Build button appears on the Real-Time Workshop
pane of the Configuration Parameters dialog box. This button completes
the entire build process and an executable image results. If you select the
Generate code only check box to the left of the button, the button label
changes to Generate code.

When you click the Build or Generate code button, Real-Time Workshop
performs the following build process. If Real-Time Workshop detects code
generation constraints for your model, it issues warning or error messages.

1 “Model Compilation” on page 2-20 — Real-Time Workshop analyzes your
block diagram (and any models referenced by Model blocks) and compiles
an intermediate hierarchical representation in a file called model.rtw.

2 “Code Generation” on page 2-20 — The Target Language Compiler reads
model.rtw, translates it to C code, and places the C file in a build directory
within your working directory.

When you click Generate code, processing stops here.

3 “Customized Makefile Generation” on page 2-21 — Real-Time Workshop
constructs a makefile from the appropriate target makefile template and
writes it in the build directory.
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4 “Executable Program Generation” on page 2-22 — Your system’s make
utility reads the makefile to compile source code, link object files and
libraries, and generate an executable image, called model (UNIX) or
model .exe (Windows). The makefile places the executable image in your
working directory.

If you select Generate HTML report on the Real-Time Workshop pane,
a navigable summary of source files is produced when the model is built.
The report files occupy a directory called html within the build directory.
The report contents vary depending on the target, but all reports feature
clickable links to generated source files. The following display shows an
example of an HTML code generation report for a generic real-time (GRT)
target.

E!Real—'[ime Workshop Report - EI|5|
Back | Forward

) Code Generation Report for
pumn oo ||Ttwdemo {14

Subsystems
Code mapping Summary

Code reuse excephions

Generated Source Files Feal-Tine Workshop code generated for Simulink model "rtwdemo_f14 mdl".

t nonfinite ¢ .

Iodel Version 0133
urdemo flde Real- Tins Workshop version: 6.5 (R2006b) 13-Tul- 2006
t nonfinie b eal-Time Workshop wersion: 6.5 (B, 3 13-Tul-

C source code generated on : Tue Jul 18 10:33:42 2006
rimodelh
riwdeme fl4.h

rturdemo F14 private b Configuration Settings at the Time of Code Generation : click to open

ttwdemo 14 typesh
ttwtypes.h

(RN

oK I Cancel | Help | Apply

For more information, see “Generate HTML Report” in the Real-Time
Workshop documentation. You can also view an HTML report in Model
Explorer. See the last part of “Generating Code for a Referenced Model” on
page 3-50 for details.

Details about each of the four steps in the process follow.
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Model Compilation

The build process begins with Simulink compiling the block diagram. During
this stage, Simulink

¢ Evaluates simulation and block parameters
* Propagates signal widths and sample times
® Determines the execution order of blocks within the model

* Computes work vector sizes, such as those used by S-functions. (For more
information about work vectors, see the Simulink Writing S-Functions
documentation.)

When Simulink completes this processing, it compiles an intermediate
representation of the model. This intermediate description is stored in a
language-independent format in the ASCII file model.rtw. The model.rtw
file is the input to the next stage of the build process.

model.rtw files are similar in format to Simulink model (.md1) files, but are
used only for automated code generation. For a general description of the
model.rtw file format, see the Target Language Compiler documentation.

Code Generation

During code generation, Real-Time Workshop uses the Target Language
Compiler (TLC) and a supporting TLC function library to transform the
intermediate model description stored in model . rtw into target-specific code.

The target language compiled by the TLC is an interpreted programming
language designed to convert a model description to code. The TLC executes a
TLC program comprising several target files (.t1lc scripts). The TLC scripts
specify how to generate code from the model, using the model . rtw file as input.
The TLC

1 Reads the model.rtw file

2 Compiles and executes commands in a system target file
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The system target file is the entry point or main file. You select it from
those available on the MATLAB path with the system target file browser or
you can type the name of any such file on your system prior to building.

3 Compiles and executes commands in block-level target files

For blocks in the Simulink model, there is a corresponding target file that
is either dynamically generated or statically provided.

Note Real-Time Workshop executes all user-written S-function target files,
but optionally executes block target files for Simulink blocks.

4 Writes a source code version of the Simulink block diagram

Customized Makefile Generation

After generating the code, Real-Time Workshop generates a customized
makefile, model .mk. The generated makefile instructs the make system utility
to compile and link source code generated from the model, as well as any
required harness program, libraries, or user-provided modules.

Real-Time Workshop creates model.mk from a system template file,
system.tmf (where system stands for the selected target name). The system
template makefile is designed for your target environment. You have the
option of modifying the template makefile to specify compilers, compiler
options, and additional information used during the creation of the executable.

Real-Time Workshop creates the model.mk file by copying the contents of
system.tmf and expanding lexical tokens (symbolic names) that describe
your model’s configuration.

Real-Time Workshop provides many system template makefiles, configured
for specific target environments and development systems. “Selecting a
System Target File” in the Real-Time Workshop documentation lists all
template makefiles that are bundled with Real-Time Workshop. To see an
example template makefile, navigate to matlabroot/rtw/c/grt, and open
with an editor the file grt_msvc.tmf. You can fully customize your build
process by modifying an existing template makefile or providing your own
template makefile.
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Executable Program Generation
The following figure shows how Real-Time Workshop controls automatic

program building.
Click Build
Button

Generate
Code

model.c
model.h
model private.h

Simulink
Model

Custom
Template Generate Makefile
Makefile Makefile model .mk

Create
Executable?

No

Invoke
make

During the final stage of processing, Real-Time Workshop invokes the
generated makefile, model .mk, which in turn compiles and links the generated
code. On PC platforms, a batch file is created to invoke the generated makefile.
The batch file sets up the proper environment for invoking the make utility
and related compiler tools. To avoid unnecessary recompilation of C files, the
make utility performs date checking on the dependencies between the object
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and C files; only out-of-date source files are compiled. Optionally, the makefile
can download the resulting executable image to your target hardware.

This stage is optional, as illustrated by the control logic in the preceding
figure. You might choose to omit this stage, for example, if you are targeting
an embedded microcontroller or a digital signal processing (DSP) board.

To omit this stage of processing, select the Generate code only option on
the Real-Time Workshop pane of the Configuration Parameters dialog
box. You can then cross-compile your code and download it to your target
hardware. “Interacting with the Build Process” in the Real-Time Workshop
documentation discusses the options that control whether or not the build
creates an executable image.

Files and Directories Created by the Build Process
The following sections discuss

¢ “Files Created During Build Process” on page 2-23
¢ “Directories Used During the Build Process” on page 2-28

Files Created During Build Process

This section lists model . * files created during the code generation and build
process for the GRT and GRT malloc targets when used with stand-alone
models. Additional directories and files are created to support shared
utilities and model references (see “Building Subsystems and Working with
Referenced Models” in the Real-Time Workshop documentation).

Real-Time Workshop derives many of the files from the model.md1 file you
create with Simulink. You can think of the model.mdl file as a very high-level
programming language source file.

Note Files generated by Real-Time Workshop Embedded Coder are packaged
slightly differently. Depending on model architectures and code generation
options, Real-Time Workshop might generate other files.
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Descriptions of the principal generated files follow. Note that these
descriptions use the generic term model for the model name:
® model.rtw

An ASCII file, representing the compiled model, generated by the
Real-Time Workshop build process. This file is analogous to the object file
created from a high-level language source program. By default, Real-Time
Workshop deletes this file when the build process is complete. However,
you can choose to retain the file for inspection.

® model.c

C source code that corresponds to model.mdl and is generated by the
Target Language Compiler. This file contains

= Include files model.h and model private.h
= All data except data placed in model data.c
= Model-specific scheduler code
= Model-specific solver code
= Model registration code
= Algorithm code
= Optional GRT wrapper functions
® model.h

Defines model data structures and a public interface to the model entry
points and data structures. Also provides an interface to the real-time
model data structure (model rtM) via access macros. model.h is included
by subsystem .c files in the model. It includes

= Exported Simulink data symbols
= Exported Stateflow machine parented data
= Model data structures, including rtm
= Model entry point functions
® model_private.h

Contains local define constants and local data required by the model and
subsystems. This file is included by the generated source files in the model.
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You might need to include model private.h when interfacing legacy
hand-written code to a model. See “Header Dependencies When Interfacing
Legacy/Custom Code with Generated Code” in the Real-Time Workshop
documentation for more information. This header file contains

= Imported Simulink data symbols
= Imported Stateflow machine parented data
= Stateflow entry points

= Real-Time Workshop details (various macros, enums, and so forth that
are private to the code)

model_types.h

Provides forward declarations for the real-time model data structure
and the parameters data structure. These might be needed by function
declarations of reusable functions. model types.h is included by all the
generated header files in the model.

model_data.c

A conditionally generated C source code file containing declarations for
the parameters data structure and the constant block I/O data structure,
and any zero representations for structure data types that are used in the
model. If these data structures are not used in the model, model data.cis
not generated. Note that these structures are declared extern in model .h.
When present, this file contains

= Constant block I/O parameters
= Include files model.h and model private.h

= Definitions for the zero representations for any user-defined structure
data types used by the model

= Constant parameters

model.exe (Windows ) or model (UNIX), generated in the current directory,
not in the build directory

Executable program file created under control of the make utility by your
development system (unless you have explicitly specified that Real-Time
Workshop generate code only and skip the rest of the build process)
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® model.mk

Customized makefile generated by the Real-Time Workshop build process.
This file builds an executable program file.

rtmodel.h

Contains #include directives required by static main program modules
such as grt_main.c and grt_malloc_main.c. Since these modules are
not created at code generation time, they include rt_model.h to access
model-specific data structures and entry points. If you create your own
main program module, take care to include rtmodel.h.

rtwtypes.h

For GRT targets, a header file that includes simstruc_types.h, which, in
turn, includes tmwtypes.h. For Real-Time Workshop Embedded Coder
ERT targets, rtwtypes.h itself provides the necessary defines, enums,
and so on, instead of including tmwtypes.h and simstruc_types.h. The
rtwtypes.h file generated for ERT is an optimized (reduced) file based
on the settings provided with the model that is being built. See “Header
Dependencies When Interfacing Legacy/Custom Code with Generated
Code” in the Real-Time Workshop documentation for more information.

rt_nonfinite.c

C source file that declares and initializes global nonfinite values for inf,
minus inf, and nan. Nonfinite comparison functions are also provided. This
file is always generated for GRT-based targets and optionally generated
for other targets.

rt_nonfinite.h

C header file that defines extern references to nonfinite variables and
functions. This file is always generated for GRT-based targets and
optionally generated for other targets.

rtw_proj.tmw

File Real-Time Workshop generated for the make utility to use to determine
when to rebuild objects when the name of the current Real-Time Workshop
project changes
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model .bat

Windows batch file used to set up the appropriate compiler environment
and invoke the make command

modelsources.txt

List of additional sources that should be included in the compilation.

Optional files:

model targ_data_map.m
M-file used by external mode to initialize the external mode connection
model dt.h

C header file used for supporting external mode. Declares structures that
contain data type and data type transition information for generated model
data structures.

subsystem.c

C source code for each noninlined nonvirtual subsystem or copy thereof
when the subsystem is configured to place code in a separate file

subsystem.h

C header file containing exported symbols for noninlined nonvirtual
subsystems. Analogous to model.h.

model_capi.h

An interface header file between the model source code and the generated
C-API. See “C-API for Interfacing with Signals and Parameters” in
Real-Time Workshop User’s Guide for more information.

model_capi.c

C source file that contains data structures that describe the model’s signals
and parameters without using external mode. See “C-API for Interfacing
with Signals and Parameters” in Real-Time Workshop User’s Guide for
more information.
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® rt_sfcn_helper.h, rt_sfcn_helper.c

Header and source files providing functions needed by noninlined
S-functions in a model. The functions rt_CallSys, rt_enableSys, and
rt _DisableSys are used when noninlined S-functions call downstream
function-call subsystems.

In addition, when you select the Generate HTML report option, Real-Time
Workshop generates a set of HTML files (one for each source file plus a
model_contents.html index file) in the html subdirectory within your build
directory.

The above source files have dependency relationships, and there are
additional file dependencies that you might need to take into account. These
are described in “Generated Source Files and File Dependencies” in the
Real-Time Workshop documentation.

Directories Used During the Build Process

Real-Time Workshop places output files in three directories during the build
process:

¢ The working directory

If you choose to generate an executable program file, Real-Time Workshop
writes the file model.exe (Windows) or model (UNIX) to your working
directory.

¢ The build directory — model_target_rtw

A subdirectory within your working directory. The build directory name

is model_target_rtw, where model is the name of the source model and
target is the selected target type (for example, grt for the generic real-time
target). The build directory stores generated source code and all other files
created during the build process (except the executable program file).

® Project directory — slprj

A subdirectory within your working directory. When models referenced
via Model blocks are built for simulation or Real-Time Workshop code
generation, files are placed in slprj. Real-Time Workshop Embedded
Coder has an option that places generated shared code in slprj without
the use of model reference. Subdirectories in slprj provide separate places
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for simulation code, some Real-Time Workshop code, utility code shared
between models, and other files. Of particular importance to Real-Time
Workshop users are

= Model reference Real-Time Workshop target files
slprij/target/modelName/

= MAT-files used during code generation of model reference
Real-Time Workshop target and stand-alone code generation

slprij/target/modelName/tmwinternal
= Shared (fixed-point) utilities
slprj/target/_sharedutils
See “Working with Project Directories” on page 3-60 for more information

on organizing your files with respect to project directories.

The build directory always contains the generated code modules model.c,
model .h, and the generated makefile model .mk.

Depending on the target, code generation, and build options you select, the
build directory might also include

* model.rtw

® Object files (.0obj or .0)

® Code modules generated from subsystems

e HTML summary reports of files generated (in the html subdirectory)

e TLC profiler report files

¢ Block I/O and parameter tuning information file (model capi.c)

® C-API code for parameters and signals

¢ Real-Time Workshop project (model.tmw) files

For additional information about using project directories, see “Project
Directory Structure for Model Reference Targets” and “Supporting Shared

Utility Directories in the Build Process” in the Real-Time Workshop
documentation.
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Working with Real-Time
Workshop

This chapter provides hands-on tutorials that help you get started generating
code with Real-Time Workshop, as quickly as possible. It includes the
following topics:

Demonstration Model: rtwdemo_f14 Describes the Simulink model that

(p. 3-3) the first three tutorials use
Building a Generic Real-Time Shows how to generate C code from
Program (p. 3-4) a Simulink demo model and build an

executable program

Data Logging (p. 3-14) Explains how to modify the
demonstration program to save data
in a MATLAB MAT-file for plotting

Code Verification (p. 3-21) Demonstrates how to verify a
generated program by comparing its
output to that of the original model
under simulation

First Look at Generated Code Examines code generated for a very

(p. 3-27) simple model, illustrating the effects
of some of Real-Time Workshop code
generation options

Working with External Mode Using Acquaints you with the basics of

GRT (p. 3-38) using external mode on a single
computer, and demonstrates the
value of external mode to rapid
prototyping
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Generating Code for a Referenced Introduces generating code for

Model (p. 3-50) models referenced with Model
blocks, and using Model Explorer
to browse code files

Documenting a Code Generation Explains how to use Simulink Report
Project (p. 3-62) Generator to generate a detailed
report for a code generation project

To get the maximum benefit from this book, The MathWorks recommends
that you study and work all the tutorials, in the order presented.

These tutorials assume basic familiarity with MATLAB and Simulink. You
should also read Chapter 2, “Building an Application”, before proceeding.

The procedures for building, running, and testing your programs are almost
identical in UNIX and PC environments. The discussion notes differences
where applicable.

Make sure that a MATLAB compatible C compiler is installed on your
system before proceeding with these tutorials. See “Supported Third-Party
Compilers” on page 1-12 in the Real-Time Workshop documentation for more
information on supported compilers and compiler installation.
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Demonstration Model: riwdemo f14

The first three tutorials use a demonstration Simulink model,
rtwdemo_f14.mdl, from the directory:

matlabroot/toolbox/rtw/rtwdemos/

By default, this directory is on your MATLAB path; matlabroot is the location
of MATLAB on your system. The rtwdemo_f14 model represents a simplified
flight controller for the longitudinal motion of a Grumman Aerospace F-14
aircraft. The figure below shows the top level of this model.

-
Stick Input z"m a force (3]

- Filot G foree

Nz pilot Scope

u loulati
|: Stick Input G}
1
P alpha (rad) Bevator Command (deg) His (| Bewator Deflection d (deg) Nz Filot (g)
Tas+1
=l q (radizec) “ertical veloeity w (ftisec) o
Controll Actuator %
ontraller Model
“ertical Gust wiGust (ft/sec
Angle of
Attack
Fitch Rate q frad/sec) |-
g Rotary Gust qGust (radisec) = 17U
o alpha (rad)
Aireraft
Dryden Wind Dynamics
Gust Madels Model

This model demonstrates the code generated for the F-14 Flight Control System. The model contains
a continuous-time controller designed entirely with Simulink blocks. You can build the entire
closed-loop model, or selectively a subsystem of interest (i g, right-click on a subsystem block and
select the option Real-Time Workshop --» Build Subsystem ..

Generate and inspect the code by double-clicking the blue buttons below. An HTML report detailing
the code is displayed automatically.

Generate Code Using

Generate Code Using
Real-Time Workshop

{douhle-click)

Real-Time Workshop
Embedded Coder
{double-click)

The model simulates the pilot’s stick input with a square wave having a
frequency of 0.5 radians per second and an amplitude of + 1. The system
outputs are the aircraft angle of attack and the G forces experienced by the
pilot. The input and output signals are visually monitored by Scope blocks.
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Building a Generic Real-Time Program

e “Tutorial Overview” on page 3-4

* “Working and Build Directories” on page 3-4

e “Setting Program Parameters” on page 3-5

e “Selecting the Target Configuration” on page 3-7

¢ “Building and Running the Program” on page 3-11
e “Contents of the Build Directory” on page 3-12

Tutorial Overview

This tutorial walks through the process of generating C code and building an
executable program from the demonstration model. The resulting stand-alone
program runs on your workstation, independent of external timing and events.

Working and Build Directories

It is convenient to work with a local copy of the rtwdemo_f14 model, stored in
its own directory, f14example. Set up your working directory as follows:

1 In MATLAB, navigate to a directory where you have write access.
2 Create the working directory from the MATLAB command line by typing:

mkdir fi4example

3 Make fi4example your working directory:

cd fl1d4example

4 Open the rtwdemo_f14 model:

rtwdemo_f14

The model appears in the Simulink window.

5 In the model window, choose File > Save As. Navigate to your working
directory, f14example. Save a copy of the rtwdemo_f14 model as
f14rtw.mdl.
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During code generation, Real-Time Workshop creates a build directory within
your working directory. The build directory name is model_target_rtw,
derived from the name of the source model and the chosen target. The build
directory stores generated source code and other files created during the build
process. You examine the build directory contents at the end of this tutorial.

Note When a model contains Model blocks (which enable one Simulink model
to include others), special project directories are created in your working
directory to organize code for referenced models. Project directories exist
alongside of Real-Time Workshop build directories, and are always named
slprj. “Generating Code for a Referenced Model” on page 3-50 describes
navigating project directory structures in Model Explorer.

Setting Program Parameters

To generate code correctly from the f14rtw model, you must change some of
the simulation parameters. In particular, note that generic real-time (GRT)
and most other targets require that the model specify a fixed-step solver.

Note Real-Time Workshop can generate code for models using variable-step
solvers for rapid simulation (rsim) and S-function targets only. A Simulink
license is checked out when rsim targets execute. See “Licensing Protocols
for Simulink Solvers in RSim Executables” in the Real-Time Workshop
documentation for details.

To set parameters, use the Model Explorer as follows:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.

4 Click Solver in the center pane. The Solver pane appears at the right.
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5 Enter the following parameter values on the Solver pane (some may

already be set):
Start Time: 0.0
Stop Time: 60
Solver options:

Type: Fixed-step
Solver: ode5 (Dormand-Prince)

Fixed step size: 0.1
Tasking mode: SingleTasking

The Solver pane with the modified parameter settings is shown below.
Note the tan background color of the controls you just changed. The color
also appears on fields that were set automatically by your choices in other
fields. Use this visual feedback to double-check that what you set is what
you intended. When you apply your changes, the background color reverts
to white.

Saolver

—Simulation tim
Start time:lU.D Stop time: |ED

—Salver optian
T_l,lpe:l Fized-step LI Solver:l ode5 [Dormand-Prince] j
Periodic: sample time constraint: | Unconstrained |

Fized-step size [fundamental sample time].|0.1

Tasking mode far periadic sample times: I SingleT asking j
[~ Higher pricrity value indicates higher task priority

v Automatically handle data transters between tasks

6 Click Apply to register your changes.

7 Save the model. Simulation parameters persist with the model, for use in

future sessions.
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Selecting the Target Configuration

Note Some of the steps in this section do not require you to make changes.
They are included to help you familiarize yourself with the Real-Time
Workshop user interface. As you step through the dialog boxes, place the
mouse pointer on any item of interest to see a tooltip describing its function.

To specify the desired target configuration, you choose a system target file, a
template makefile, and a make command.

In these tutorials (and in most applications), you do not need to specify these
parameters individually. Here, you use the ready-to-run generic real-time
target (GRT) configuration. The GRT target is designed to build a stand-alone
executable program that runs on your workstation.

To select the GRT target via the Model Explorer:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.

4 Click Real-Time Workshop in the center pane. The Real-Time
Workshop pane appears at the right. This pane has several tabs.

5 Click the General tab to activate the pane that controls target selection.

6 Click the Browse button next to the System target file field. This
opens the System Target File Browser, illustrated below. The browser
displays a list of all currently available target configurations. Your
available configurations may differ. When you select a target configuration,
Real-Time Workshop automatically chooses the appropriate system target
file, template makefile, and make command. Their names appear at the
bottom left of the window.
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Note The system target file browser lists all system target files found on
the MATLAB path. Using some of these might require additional licensed
products, such as Real-Time Workshop Embedded Coder.

=] 5¥stem target file browser: riwdemo_f14

x|
System targe! file: Description: A
ert tic Real-Time Workshop Embedded Coder (no auto configuration) -
ert tlc Real-Time Workshop Embedded Coder (auto configures for optimized fimed-point
ert tlc Real-Time Workshop Embedded Coder (auto configures for optimized floating-poi
ert tlc Visual C/C

FProject Makefile only for the Real-Tine Workshop Embedded Coder
T

grt . tlc Visual
grt_malloc tle
grt_malloc tle
i e
Full name: E:matlabhmwtchgrthgrt He

Template make file: grit_default_tmf

Make command:  make_rtw

++ Froject Makefile only for the "grt' target
Generic Real-Time Target with dynamic memory allocation

Visual CsC++ Project Makefile only for the "grt_malloc" target

L |«|

0Ok I Cancel | Help | £aply

7 From the list of available configurations, select Generic Real-Time
Target (as shown above) and then click OK.

The Real-Time Workshop pane displays the correct system target
file (grt.tlc), make command (make rtw), and template makefile
(grt_default_tmf), as shown below:

Real-Time Workshop

General ICommenls I Symbols I Custom Code I Debug I Interface I
— T arget selection

Syztem target file: Igrt tic: Browsze:

Language: | C ;I
Description: Generic Real-Time Target

—Documentation
[¥ Generats HTHL report

¥ Launch repart automatically

—Build proc

TLC options: |-DEI -gw arnMonS aturatedBlock:=0
I akefile canfiguration

[¥ Generate makefie

take command: |makefrtw

Template makefile: Igrt_defau\t_tmf

[~ Generate code only Build |
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8 Select the Debug tab of the Real-Time Workshop pane. The options
displayed here control build verbosity and debugging support, and are
common to all target configurations. Make sure that all options are set
to their defaults, as shown below.

Real-Time Workzhop

General I Comments | Symbolz | Custom Cade | Debug Ilnterface

—Build proc
¥ “erbose huild
I Fietain v file

—TLLC procs
I~ Profile TLC

I~ Start TLC debugger when generating code
I~ Start TLC coverage when generating code
[~ Enable TLC aszertion

9 Select the Symbols tab of the Real-Time Workshop pane. The options
on this pane control the look and feel of generated code. Only one option
exists for the GRT target, Maximum identifier length (the number of
characters allowed in variable and other symbol names). The default for

this option is 31, as shown below.

Real-Time Workshop

General I Comments |5Pmbo\s ICustDm Code I Debug | Interface

Luto-generated identifier naming il
’7 M axirnumn identifier Iength:|31
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10 Select the Comments tab of the Real-Time Workshop pane. The options
displayed here control the types of comments included in generated code.
Make sure that all options are set to their defaults, as shown below.

Real-Time Workshop

General Comments | Symbols I Custom Code I Debug Inlelfacel

— Oweral control

V' Include comments

— Auto generated comment:

IV Sirmulink black comments
™ Show eliminated blocks

¥ Verbose comments for SimulinkGlobal storage class

™ Generate code only Build |

11 Make sure that the Generate code only option is not checked, as shown
at the bottom of the preceding figure.

12 Save the model.
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Building and Running the Program

The Real-Time Workshop build process generates C code from the model,
and then compiles and links the generated program to create an executable
image. To build and run the program,

1 In the Real-Time Workshop pane, select the General tab, then click the
Build button to start the build process.

A number of messages concerning code generation and compilation appear
in the MATLAB Command Window. The initial messages are

### Starting Real-Time Workshop build procedure for model:
fl4rtw
### Generating code into build directory: f14rtw_grt_rtw

A code generation report is displayed after the code is generated because
the Generate HTML report and Launch report automatically options
in the Real-Time Workshop General tab are checked.

The contents of many of the succeeding messages depends on your compiler
and operating system. The final message is

### Successful completion of Real-Time Workshop build procedure
for model: f14rtw

The working directory now contains an executable, f14rtw.exe (Windows)
or f14rtw (UNIX). In addition, Real-Time Workshop has created a project
directory, slprj, a build directory, f14rtw_grt_rtw, and a report file
directory, html, in your working directory.

2 To observe the contents of the working directory after the build, type the
dir command from the Command Window.

dir
f14rtw.exe fl4rtw_grt_rtw
fl14rtw.mdl slprj

3 To run the executable from the Command Window, type

1f14rtw
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The ! character passes the command that follows it to the operating system,
which runs the stand-alone f14rtw program.

The program produces one line of output in the Command Window:

**starting the model**

No data is output.
4 Finally, to see the files created in the build directory, type

dir f14rtw_grt_rtw

Contents of the Build Directory

The build process creates a build directory and names it model target rtw,
concatenating the name of the source model and the chosen target. In this
example, the build directory is named f14rtw_grt_rtw.

The build directory includes these generated files (not in this order):

File Description

fl14rtw.c Stand-alone C code that implements the model

rt_nonfinite.c Function to initialize nonfinite types (Inf, NaN,
and -Inf)

f14rtw.h An include header file containing definitions of
parameters and state variables

f14rtw_types.h Forward declarations of data types used in the
code

f14rtw_private.h Header file containing common include
definitions

rt_nonfinite.h Imported declarations for nonfinite types

rtwtypes.h Static include file for Simulink simstruct data

types; some embedded targets tailor this file to
reduce overhead, but GRT does not
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File Description

rtmodel.h Master header file for including generated code
in the static main program (its name never
changes, and it simply includes f14rtw.h)

f14rtw.mk Makefile generated from a template for the
GRT target

The build directory also contains other files used in the build process, such
as the object (.obj) files, a batch control file (f14rtw.bat), and a marker
file (rtw_proj.tmw). The build directory contains a subdirectory, html,
containing HTML files that report on the build process and show the code
that it generated.
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Data Logging

e “Tutorial Overview” on page 3-14
® “Data Logging During Simulation” on page 3-15
® “Data Logging from Generated Code” on page 3-17

Tutorial Overview

Real-Time Workshop MAT-file data logging facility enables a generated
program to save system states, outputs, and simulation time at each model
execution time step. The data is written to a MAT-file, named (by default)
model .mat, where model is the name of your model. In this tutorial, data
generated by the model f14rtw.mdl is logged to the file f14rtw.mat. Refer
to “Building a Generic Real-Time Program” on page 3-4 for instructions on
setting up f14rtw.mdl in a working directory if you have not done so already.

To configure data logging, click Data Import/Export in the center pane of the
Model Explorer. The process is the same as configuring a Simulink model to
save output to the MATLAB workspace. For each workspace return variable
you define and enable, Real-Time Workshop defines a parallel MAT-file
variable. For example, if you save simulation time to the variable tout, your
generated program logs the same data to a variable named rt_tout. You can
change the prefix rt_ to a suffix (_rt), or eliminate it entirely. You do this by
selecting Real-Time Workshop in the center pane of the Model Explorer,
then clicking the Interface tab.

Note Simulink lets you log signal data from anywhere in a model via the Log
signal data option in the Signal Properties dialog box (accessed via context
menu by right-clicking signal lines). Real-Time Workshop does not use this
method of signal logging in generated code. To log signals in generated code,
you must either use the Data Import/Export options described below or
include To File or To Workspace blocks in your model.

In this tutorial, you modify the f14rtw model so that the generated program
saves the simulation time and system outputs to the file f14rtw.mat. Then
you load the data into the MATLAB workspace and plot simulation time
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against one of the outputs. The f14rtw model should be open and configured
as it was at the end of the previous tutorial.

Data Logging During Simulation
To use the data logging feature:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.

4 Click Data Import/Export in the center pane. The Data Import/Export
pane appears at the right. Its Save to workspace section lets you specify
which outport data is to be saved to the workspace and what variable
names to use for it.

5 Select the Time option. This tells Simulink to save time step data during
simulation as a variable named tout. You can enter a different name to
distinguish different simulation runs (for example using different step
sizes), but take the default for this tutorial. Selecting Time enables
Real-Time Workshop to generate code that logs the simulation time to
a MAT-file.

6 Select the Output option. This tells Simulink to save time step data
during simulation as a variable named yout. Selecting Output enables
Real-Time Workshop to generate code that logs the root Output blocks
(Angle of Attack and Pilot G Force) to a MAT-file.

Note The sort order of the yout array is based on the port number of the
Outport blocks, starting with 1. Angle of Attack and Pilot G Force are
logged to yout(:,1) and yout(:,2), respectively.
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7 If any other options are enabled, clear them. Set Decimation to 1 and
Format to Array. The figure below shows the dialog.

Data Import/E xport

—Load fram waork spac:

I~ Irput o

™ Initial state: |[]

—Save to workspac

W Time: Iluul
I~ States: Ikout
¥ Output: Iyout

™ Final states: IxF\naI

I~ Signal logging: |IogsD ut

I™ Inspect signal logs when simulation is paused/stopped

—Save optioh
[™ Limit data points to last |1DDU Drecimation: |1
Format: I Biray I

8 Click Apply to register your changes.

9 Save the model.

10 Open the Pilot G Force Scope block of the model, then run the model by
choosing Simulation > Start in the model window. The resulting Pilot G
Force scope display is shown below.

L-TE
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11 Verify that the simulation time and outputs have been saved to the
MATLAB workspace in MAT-files. At the MATLAB prompt, type:

whos *out

Simulink displays:

Name Size Bytes Class Attributes
tout 601x1 4808 double
yout 601x2 9616 double

12 Verify that Pilot G Force was correctly logged by plotting simulation time
versus that variable. At the MATLAB prompt, type:

plot(tout,yout(:,2))
The resulting plot is shown below.

ol

File Edit View Insert Tools Deskiop Window Help

Deds k| aanhe || 08| a0

15

4
-10 K/

Data Logging from Generated Code

In the second part of this tutorial, you build and run a Real-Time Workshop
executable of the f14rtw model that outputs a MAT-file containing the
simulation time and outputs you previously examined. Even though you
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have already generated code for the f14rtw model, you must now regenerate
that code because you have changed the model by enabling data logging. The
steps below explain this procedure.

To avoid overwriting workspace data with data from simulation runs,
Real-Time Workshop modifies identifiers for variables logged by Simulink.
You can control these modifications from the Model Explorer:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.

4 In the center pane, click Real-Time Workshop. The Real-Time
Workshop pane appears to the right.

5 Click the Interface tab.

6 Set MAT-file variable name modifier to _rt. This adds the suffix _rt
to each variable that you selected to be logged in the first part of this
tutorial (tout, yout).

7 Clear the Generate code only check box, if it is currently selected. The
pane should look like this:

Real-Time Workshop

General I Comments I Symbols | Custom Code I Debug | Interface |

—Software environment

Target floating-paint math environment: I CE3/C30 [ANS51) j

Utility function generation I Auto ;I
—Werification

MAT -file variable name modifier:l _it LI
—Data exchang

Interface: | None ;I

I~ Generate code only Build |
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8 Click Apply to register your changes.

9 Save the model.
10 To generate code and build an executable, click the Build button.
11 When the build concludes, run the executable with the command:

f14rtw

12 The program now produces two message lines, indicating that the MAT-file
has been written.

** gtarting the model **
** created fi1d4rtw.mat **

13 Load the MAT-file data created by the executable and look at the workspace
variables from simulation and the generated program by typing:

load f14rtw.mat
whos tout* yout*

Simulink displays:

Name Size Bytes Class Attribute
tout 601x1 4808 double
tout_rt 601x1 4808 double
yout 601x2 9616 double
yout_rt 601x2 9616 double

Note that all arrays have the same number of elements.
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14 Observe that the variables tout rt (time) and yout rt (Pilot G Force
and Angle of Attack) have been loaded from the file. Plot Pilot G Force
as a function of time.

plot(tout_rt,yout_rt(:,2))

The resulting plot is identical to the plot you produced in step 10 of the
previous part of this tutorial:

=lolx|

File Edit View Insert Tools Desktop ‘Window Help

D& h|RAQaN®|(w 08|50
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Code Verification

e “Tutorial Overview” on page 3-21

* “Logging Signals via Scope Blocks” on page 3-21

® “Logging Simulation Data” on page 3-23

* “Logging Data from the Generated Program” on page 3-23

® “Comparing Numerical Results of the Simulation and the Generated
Program” on page 3-26

Tutorial Overview

In this tutorial, you verify the answers computed by code generated from the
f14rtw model. You do this by capturing two sets of output data and comparing
the sets. You obtain one set by running the model itself in Simulink, and the
other set by executing code generated from the model by Real-Time Workshop.

Note To obtain a valid comparison between outputs of the model and the
generated program, you must use the same Solver options and the same
Step size for both the Simulink run and the Real-Time Workshop build
process, and the model must be configured to save simulation time, as shown
in the preceding tutorial.

Logging Signals via Scope Blocks

This example uses Scope blocks (rather than Outport blocks) to log output
data. The f14rtw model should be configured as it was at the end of the
previous tutorial, “Data Logging” on page 3-14.

To configure the Scope blocks to log data,

1 Save the model if any unsaved changes exist.

2 Clear the MATLAB workspace to eliminate the results of previous
simulation runs. At the MATLAB prompt, type:

clear
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The clear operation clears not only variables created during previous
simulations, but all workspace variables, some of which are standard
variables that the f14rtw model requires.

3 Reload the model so that the standard workspace variables are redeclared
and initialized:

a Close the model by clicking its window’s Close box.

b At the MATLAB prompt, type:

fl1drtw

The model reopens, which declares and initializes the standard
workspace variables.

4 Open the Stick Input Scope block and click the Parameters button (the
second button from the left) on the toolbar of the Scope window. The Stick
Input Parameters dialog box opens.

5 Click the Data History tab of the Stick Input Parameters dialog box.

6 Select the Save data to workspace option and change the Variable
name to Stick_input. The dialog box appears as follows:

<) 'Stick Input’ parameters i ] |

General | Diata history

¥ Limit data points to last:  [S000

Tig: try right clicking on sxes

¥ Save datato workspace

‘ariahle hame: IStick_input\

Fortnat: I Array d

QK | Cancell Help | Apply |

7 Click OK.

The Stick Input parameters now specify that the Stick Input signal to the
Scope block will be logged to the array Stick input during simulation.
The generated code will log the same signal data to the MAT-file variable
rt_Stick_input during a run of the executable program.
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8 Configure the Pilot G Force and Angle of Attack Scope blocks similarly,
using the variable names Pilot G _force and Angle of attack.

9 Save the model.

Logging Simulation Data
The next step is to run the simulation and log the signal data from the Scope

blocks:
1 Open the Stick Input, Pilot G Force, and Angle of Attack Scope blocks.

2 Run the model. The three Scope plots look like this:

) srckmpue — -inix ~i01.xI| BT — iBix
SHECLL ABE| P E & SHELCALL HEBE|PDE &

SEPLL. HEEIBA R

3 Use the whos command to show that the array variables Stick_input,
Pilot_G_force, and Angle_of_attack have been saved to the workspace.

4 Plot one or more of the logged variables against simulation time. For

example,
plot(tout, Stick_input(:,2))
Logging Data from the Generated Program

Because you have modified the model, you must rebuild and run the f14rtw
executable to obtain a valid data file:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.
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3 Click Configuration (Active) in the left pane.

4 Select Real-Time Workshop on the center pane of the Model Explorer,
and click the Interface tab. The Interface pane appears.

5 Set the MAT-file variable name modifier menu to rt_. This prefixes
rt_ to each variable that you selected to be logged in the first part of this
tutorial.

6 Click Apply.
7 Save the model.

8 Generate code and build an executable by clicking the Build button. Status
messages in the MATLAB Command Window track the build process.

9 When the build finishes, run the stand-alone program from MATLAB.

1f14rtw

The executing program writes the following messages to the MATLAB
Command Window.

** gtarting the model **
** created fi1d4rtw.mat **

10 Load the data file f14rtw.mat and observe the workspace variables.

>> load fl4rtw
>> whos rt*

Name Size Bytes Class Attributes
rt_Angle_of_attack 601x2 9616 double
rt_Pilot_G_force 601x2 9616 double
rt_Stick_input 601x2 9616 double
rt_tout 601x1 4808 double
rt_yout 601x2 9616 double
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11 Use MATLAB to plot three workspace variables created by the executing
program as a function of time.

figure('Name', 'Stick_input')
plot(rt_tout,rt_Stick_input(:,2))
figure('Name','Pilot_G_force')
plot(rt_tout,rt_Pilot_G_force(:,2))
figure('Name', 'Angle_of_attack')
plot(rt_tout,rt_Angle_of_attack(:,2))

<} Figure 1: Stick_input M [=[ESl -} Figure 2: Pilot_G_force M [=[ESWN -) Figure 3: angle_of_attack | —1o) x|
File Edt View Insert Tools Desktop Window Help File Edt View Insert Tools Deskiop “Window Help File Edit Wiew Insert Tools Desktop Window Help
s k Ra0M® € 08 (|0edE8 F RAN8 € I8 foeEs bk R0 € 08 «
1 20 2
0s 10 1
D : D MW
-0.5 -10 =
Bl 20 2
o 10 20 a0 40 A0 B0 o 10 20 30 a0 a0 B0 o 10 20 a0 40 A0 B0

Your Simulink simulations and the generated code have apparently
produced nearly identical output. The next section shows how to quantify
this similarity.
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Comparing Numerical Results of the Simulation and
the Generated Program

You have now obtained data from a Simulink run of the model and from a run
of the program generated from the model. It is a simple matter to compare the
f14rtw model output to the results achieved by Real-Time Workshop. Your
comparison results may differ from those shown below.

To compare Angle of attack (simulation output) to rt_Angle of attack
(generated program output), type:

max (abs(rt_Angle_of_attack-Angle_of_attack))

MATLAB prints:

ans =
1.0e-015 *
0 0.3331

Similarly, the comparison of Pilot G force (simulation output) to
rt_Pilot_G_force (generated program output) is:

max(abs(rt_Pilot_G_force-Pilot_G_force))
1.0e-013 *
0 0.4974

Overall agreement is within 1012, The means of residuals are an order of
magnitude smaller. This slight error can be caused by many factors, including
¢ Different compiler optimizations

e Statement ordering

¢ Runtime libraries

For example, a function call such as sin(2.0) might return a slightly different

value depending on which C library you are using. Such variations can also
cause differences between your results and those shown above.
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First Look at Generated Code

e “Tutorial Overview” on page 3-27

e “Setting Up the Model” on page 3-28

¢ “Generating Code Without Buffer Optimization” on page 3-29
® “Generating Code with Buffer Optimization” on page 3-32

¢ “Further Optimization: Expression Folding” on page 3-34

e “HTML Code Generation Reports” on page 3-35

Tutorial Overview

In this tutorial, you examine code generated from a simple model to observe
the effects of some of the many code optimization features available in
Real-Time Workshop.

Note You can view the code generated from this example using the MATLAB
editor. You can also view the code in the MATLAB Help browser if you enable
the Create HTML report option before generating code. See the following
section, “HTML Code Generation Reports” on page 3-35, for an introduction
to using the HTML report feature.

The source model, example.mdl, is shown below.

)
U sin_out 1 gain_out

Cut1

Sine Miave =ain
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Setting Up the Model

First, create the model from Simulink library blocks, and set up basic
Simulink and Real-Time Workshop parameters as follows:

1 Create a directory, example codegen, and make it your working directory:

!mkdir example_codegen
cd example_codegen

2 Create a new model and save it as example.mdl.

3 Add Sine Wave, Gain, and Outl blocks to your model and connect them as
shown in the preceding diagram. Label the signals as shown.

4 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

5 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

6 Click Configuration (Active) in the left pane.
7 Select Solver in the center pane. The Solver pane appears at the right.

8 In the Solver Options pane:
a Select Fixed-step in the Type field.
b Select discrete (no continuous states) in the Solver field.

¢ Specify 0.1 in the Fixed-step size field. (Otherwise, Real-Time
Workshop will post a warning and supply a default value when you
generate code.)

9 Click Apply.

10 Click Data Import/Export in the center pane and make sure all check
boxes in the right pane are cleared. Click Apply if you made any changes.

11 Select Real-Time Workshop in the center pane. Under Target Selection
in the right pane, select the default generic real-time (GRT) target grt.tlc.
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12 Select Generate code only at the bottom of the right pane. This option
causes Real-Time Workshop to generate code and a make file, then stop at
that point, rather than proceeding to invoke make to compile and link the
code. Note that the label on the Build button changes to Generate code.

13 Click Apply.

14 Save the model.

Generating Code Without Buffer Optimization

When the block I/O optimization feature is enabled, Real-Time Workshop uses
local storage for block outputs wherever possible. In this tutorial, you disable
this option to see what the nonoptimized generated code looks like:

1 Select Optimization in the center pane. The Optimization pane appears
at the right. Clear the Signal storage reuse option, as shown below.
Change any other attributes as needed to match the figure.

Optimization
—Simulation and code generation

[ Block reduchion

|¥ Conditional input branch execution
[~ Implement logic signals as boolean data [vs. double). [~ Signal storage reuse

[~ Inline parameters Caonfigure..... |

Application lifespan [da_l,ls]l\nf

—Code generation

—Signal

[T Enable lacal Block cutputs I”  Feuse Block outputs
[™ lgnore integer downcasts in folded expressions [ Irling invariant signals

I™ Eliminate superflunus temporan varables [Expression folding)

Loop unroling threshald: |5

—Integer and fized-point

I~ Remove code from foating-point to integer conversions that wraps out-of-range wvalues

2 Click Apply.

3 Select Real-Time Workshop in the center pane, and click Generate code
on the right.
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4 Because the Generate code only option was selected, Real-Time
Workshop does not invoke your make utility. The code generation process
ends with this message:

### Successful completion of Real-Time Workshop
build procedure for model: example

5 The generated code is in the build directory, example grt rtw. The file
example grt rtw/example.c contains the output computation for the
model. Open this file in the MATLAB editor.

6 In example.c, find the function example output near the top of the file.

The generated C code consists of procedures that implement the algorithms
defined by your Simulink block diagram. The execution engine calls the
procedures in proper succession as time moves forward. The modules that
implement the execution engine and other capabilities are referred to
collectively as the run-time interface modules. See Real-Time Workshop
User’s Guide for a complete discussion of how Real-Time Workshop interfaces
and executes application, system-dependent, and system-independent
modules, in each of the two styles of generated code.

In code generated for example, the generated example output function
implements the actual algorithm for multiplying a sine wave by a gain.

The example output function computes the model’s block outputs. The
run-time interface must call example output at every time step. With buffer
optimizations turned off, example output assigns unique buffers to each block
output. These buffers (rtB.sin_out, rtB.gain_out) are members of a global
block I/0 data structure, called in this code example B and declared as follows:

/* Block signals (auto storage) */
BlockIO_example example_B;

The data type BlockIO_example is defined in example.h as follows:

/* Block signals (auto storage) */

typedef struct {
real T sin_out; /* '<Root>/Sine Wave' */
real T gain_out; /* '<Root>/Gain' */

} BlockIO_example;
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The output code accesses fields of this global structure, as shown below:

/* Model output function */
static void example_output(int_T tid)
{
/* Sin: '<Root>/Sine Wave' */
example B.sin_out = sin(example M->Timing.t[0] * example_P.SineWave_Freq +
example P.SineWave_Phase) * example P.SineWave_ Amp + example P.SineWave_ Bias;

/* Gain: '<Root>/Gain' */
example_B.gain_out = example_B.sin_out * example_P.Gain_Gain;

/* Outport: '<Root>/Outl' */
example_Y.Out1 = example_B.gain_out;
UNUSED_PARAMETER (tid) ;

7 In GRT targets such as this, the function example output is called
by a wrapper function, Md10Qutputs. In example.c, find the function
Md1lOutputs near the end. It looks like this:

void Md1lOutputs(int_T tid)

{
example output(tid);

}

Note In previous releases, Md10utputs was the actual output function for
code generated by all GRT-configured models. It is now implemented as a
wrapper function to provide greater compatibility among different target
configurations.

In the steps below, you turn buffer optimizations on and observe how these
optimizations improve the code.
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Generating Code with Buffer Optimization

Enable signal buffer optimizations and regenerate the code as follows:

1 Change your current working directory back to example codegen if you
have not already done so.

2 Select Optimization in the center pane. The Optimization pane appears
at the right. Select the Signal storage reuse option.

3 Note that three controls become enabled in the Code generation section:
Enable local block outputs, Reuse block outputs, and Eliminate
superfluous temporary variables (Expression folding). Make sure
that the first two options are selected, and Eliminate superfluous

temporary variables (Expression folding) is not selected, as shown
below.

Optimization

— Simulation and code generation

¥ Block reduction ¥ Canditional input branch execution

[~ Implemert logic signals as boolean data [vs. double). [w Signal storage reuse

[ Inline parameters Canfigure ... |

Application lifespan [days]linf

—Code generation

—Signal

[v Enable local block outputs

™ lgnore integer downcasts in folded expressions [~ Inline invariant sianals

[ Eliminate superfluous temporany vanables [Expression folding)

Loop unrolling threzhald: |5

—Integer and fized-point

I~ Remove code from floating-paint ta integer conversions that wiaps out-ofrange values

You will observe the effects of expression folding later in this tutorial. Not
performing expression folding allows you to see the effects of the block
output optimizations.

4 Click Apply to apply the new settings.

5 Select Real-Time Workshop in the center pane, and click Generate code
on the right.
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As before, Real-Time Workshop generates code in the example grt rtw
directory. The previously generated code is overwritten.

6 Edit example grt rtw/example.c and examine the function
example_output.

With buffer optimizations enabled, the code in example output reuses
temporary buffers with local scope, rtb_sin_out and rtb_gain_out, rather
than assigning global buffers to each input and output.

/* Model output function */
static void example_output(int_T tid)

{

/* local block i/o variables */
real_T rtb_sin_out;

/* Sin: '<Root>/Sine Wave' */
rtb_sin_out = sin(example_M->Timing.t[0] * example_P.SineWave_Freq +
example_P.SineWave_Phase) * example_P.SineWave_Amp +

example_P.SineWave_Bias;

/* Gain: '<Root>/Gain' */
rtb_sin_out *= example_P.Gain_Gain;

/* Outport: '<Root>/Outl' */
example_Y.Out1 = rtb_sin_out;
UNUSED_PARAMETER (tid);

This code is more efficient in terms of memory usage. The efficiency
improvement gained by enabling Enable local block outputs and Reuse
block outputs would be more significant in a large model with many signals.
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Further Optimization: Expression Folding

As a final optimization, you turn on expression folding, a code optimization
technique that minimizes the computation of intermediate results and the
use of temporary buffers or variables.

Enable expression folding and regenerate the code as follows:

1 Change your current working directory back to example codegen if you
have not already done so.

2 Select Optimization in the center pane. The Optimization pane appears.

3 Select the Eliminate superfluous temporary variables (Expression
folding) option.

Optimization

— Simulation and code generation
[ Block reduction [¥ Conditional input branch execution
[~ Implement logic signals as boolean data [vs. double). ¥ Signal storage reuse

[~ Inline parameters Caonfigure..... |

Application lifespan [days]l\nf

—LCode generation

—Signal
[¥ Enable local block outputs ¥ Feuse block outputs

[ lgnore integer downcasts in folded expressions [ Irline invariant signals

[v :Eliminate superfluous tempaoray variables [Expression folding):

Loop unrolling threshald: |5

—Integer and fized-paoint

[~ Remove code from Hoating-point bo integer corversions that wraps out-of-range values

4 Click Apply.

5 Select Real-Time Workshop in the center pane, and click Generate code
on the right.

Real-Time Workshop generates code as before.

6 Edit example grt rtw/example.c and examine the function
example_output.
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In the previous examples, the Gain block computation was computed in a
separate code statement and the result was stored in a temporary location
before the final output computation.

With Eliminate superfluous temporary variables (Expression folding)
selected, there is a subtle but significant difference in the generated code:
the gain computation is incorporated (or folded) directly into the Outport
computation, eliminating the temporary location and separate code statement.
This computation is on the last line of the example output function.

/* Model output function */
static void example_output(int_T tid)
{
/* Outport: '<Root>/Out1' incorporates:
* Gain: '<Root>/Gain'
* 8in: '<Root>/Sine Wave'
*/
example_Y.Out1 = (sin(example_M->Timing.t[0] * example_P.SineWave_Freq +
example P.SineWave_Phase) * example_ P.SineWave_ Amp +
example P.SineWave_Bias) * example_P.Gain_Gain;
UNUSED_PARAMETER (tid) ;
}

In many cases, expression folding can incorporate entire model computations
into a single, highly optimized line of code. Expression folding is turned on by
default. Using this option will improve the efficiency of generated code.

HTML Code Generation Reports

When the Generate HTML report option on the Real-Time Workshop
pane is selected, a navigable summary of source files is produced when the
model is built. See the figure below.

Selecting this option causes Real-Time Workshop to produce an HTML file for
each generated source file, plus a summary and an index file, in a directory
named html within the build directory. If the Launch report automatically
option (which is enabled by selecting Generate HTML report) is also
selected, the HTML summary and index are automatically displayed.
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In the HTML report, you can click links in the report to inspect source and
include files, and view relevant documentation. In these reports,
® Global variable instances are hyperlinked to their definitions.

¢ Block header comments in source files are hyperlinked back to the model;
clicking one of these causes the block that generated that section of code
to be highlighted (this feature requires Real-Time Workshop Embedded
Coder and the ERT target).

An HTML report for the example.mdl GRT target is shown below.

JRI=TE]
Back Farward

Code Generation Report for

Contents

Summary 1
Remors cxamplc
Subsystems

Clode mapping Summary

Code reuse exceptions
Generated Source Files
example.c

example datac

1 nonfinite
examnple.h

example private h
example types.h

1t nonfinite b
smedelh

rwiypes.h

Eeal-Tine Workshop code generated for Smulnk model "example.mdl"

Model Version 112
Feal-Time Worlcshop version: 6.5 (R2006b) 13-Jul-2006
C source code generated on - Tue Tul 18 11:40:31 2006

Configuration Settings at the Tine of Code Generation : chck to open

Lancel | Help | Lpply. |

One useful feature of HTML reports is the link on the Summary page
identifying Configuration Settings at the Time of Code Generation. Clicking
this opens a read-only Configuration Parameters dialog box through which
you can navigate to identify the settings of every option in place at the time
that the HTML report was generated.

You can refer to HTML reports at any time. To review an existing HTML
report after you have closed its window, use any HTML browser to open the
file html/model_codgen_rpt.html within your build directory.
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Note The contents of HTML reports for different target types vary, and
reports for models with subsystems feature additional information. You

can also view HTML-formatted files and text files for generated code and
model reference targets within Model Explorer. See “Generating Code for a
Referenced Model” on page 3-50 for more information.

For further information on configuring and optimizing generated code, consult
these sections of the Real-Time Workshop User’s Guide documentation:

® “Code Generation and the Build Process” contains overviews of controlling
optimizations and other code generation options.

® “Optimizing a Model for Code Generation” has additional details on signal
reuse, expression folding, and other code optimization techniques.

® “Program Architecture” has details on the structure and execution of
model.c files.
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Working with External Mode Using GRT

e “Tutorial Overview” on page 3-38

e “Setting Up the Model” on page 3-39

e “Building the Target Executable” on page 3-41

¢ “Running the External Mode Target Program” on page 3-44

¢ “Tuning Parameters” on page 3-48

Tutorial Overview

This section provides step-by-step instructions for getting started with
external mode, a very useful environment for rapid prototyping. The tutorial
consists of four parts, each of which depends on completion of the preceding
ones, in order. The four parts correspond to the steps that you follow in
simulating, building, and tuning an actual real-time application:

1 Set up the model.

2 Build the target executable.

3 Run the external mode target program.
4 Tune parameters.

The example presented uses the generic real-time target, and does not require
any hardware other than the computer on which you run Simulink and
Real-Time Workshop. The generated executable in this example runs on the
host computer in a separate process from MATLAB and Simulink.

The procedures for building, running, and testing your programs are almost
identical in UNIX and PC environments. The discussion notes differences

where applicable.

For a more thorough description of external mode, including a discussion of all
the options available, see “Using the External Mode User Interface” in the
Real-Time Workshop documentation.
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Setting Up the Model

In this part of the tutorial, you create a simple model, extmode example, and
a directory called ext_mode_example to store the model and the generated
executable:

1 Create the directory from the MATLAB command line by typing

mkdir ext_mode_example

2 Make ext_mode_example your working directory:

cd ext_mode_example

3 Create a model in Simulink with a Sine Wave block for the input signal, two
Gain blocks in parallel, and two Scope blocks. The model is shown below.
Be sure to label the Gain and Scope blocks as shown, so that subsequent
steps will be clear to you.

Gain A Scope A
I
¥
Sine Wave H |:|
Gain B Scope B

4 Define and assign two variables A and B in the MATLAB workspace as
follows:

A=2; B=3;

5 Open Gain block A and set its Gain parameter to the variable A.
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mﬂlock Parameters: Gain A

2=

Gal
’7 Element-wize gain [y = K.*u] or matrix gain [y = K*u ar p = u*K].

tdain I Signal data types I Parameter data types

Gain

Ja

Multiplication: | Elerment-wizelk. *u]

Sample time [-1 for inherited):

|1

OK I LCancel | Help |

Apply |

6 Similarly, open Gain block B and set its Gain parameter to the variable B.

When the target program is built and connected to Simulink in external
mode, you can download new gain values to the executing target program
by assigning new values to workspace variables A and B, or by editing
the values in the block parameters dialog. You explore this in “T'uning
Parameters” on page 3-48.

7 Verify correct operation of the model. Open the Scope blocks and run the

model. When A = 2 and B

-} Scope A

= 3, the output looks like this.

-ioxi| PSR

lemcer ABRE D

=101

lemcer ABRE D

8 From the File menu, choose Save As. Save the model as

extmode_example.mdl.
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Building the Target Executable

In this section, you set up the model and code generation parameters required
for an external mode compatible target program. Then you generate code and
build the target executable:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.
4 Select Solver in the center pane. The Solver pane appears at the right.

5 In the Solver Options pane:
a Select Fixed-step in the Type field.
b Select discrete (no continuous states) in the Solver field.

¢ Specify 0.1 in the Fixed-step size field. (Otherwise, Real-Time
Workshop will post a warning and supply a value when you generate
code.)

6 Click Apply. The dialog box appears below. Note that after you click
Apply, the controls you changed again have a white background color.

Solver

—Simulation tim

Start time:lU.D Stop time: |1 Q0o

—Salver optian

Type:l Fized-step j Snlver:l discrete [no continuous states)

=]
Periodic zample time constraint: | Unconstrained x|

Fized-step size [fundamental sample time): ID 1

Tasking made for periodic sample times: IAuto ;I
I~ Higher pricrity value indicates higher task priority

[~ Automaticaly handle data transfers bebwesn tasks

7 Click Data Import/Export in the center pane, and clear the Time and
Output check boxes. In this tutorial, data is not logged to the workspace or
to a MAT-file. Click Apply.
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8 Click Optimization in the center pane. Make sure that the Inline
parameters option is not selected. Although external mode supports
inlined parameters, you will not explore them in this tutorial. Click Apply
if you have made any changes.

9 Click Real-Time Workshop in the center pane. By default, the generic
real-time (GRT) target is selected on the Real-Time Workshop pane.
Select the Interface tab. The Interface pane appears at the right.

10 In the Interface pane, select External mode from the Interface pulldown
menu in the Data exchange section. This enables generation of external
mode support code and reveals two more sections of controls: Host/Target
interface and Memory management.
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11 Set the Transport layer pulldown menu in the Host/Target interface

section to tcpip. The pane now looks like this:

—Software erviranment

Target floating-paint math ervironment: I CB3/C90 [AMSI) j

Utility function generation I Auto ;I
—Werfication

MAT file wariable name modifier:l _ LI
—Data exchang

Interface: | External mode ;I

—Host/Target interfac:

Tranzpart layer: I tepip vl ME=file name: ext_comm

MEX-file arguments:l

—Memary management

[ Static memony allocation

External mode supports communication via TCP/IP, serial, and custom
transport protocols. The MEX-file name field specifies the name of a
MEX-file that implements host and target communications on the host side.
The default for TCP/IP is ext_comm, a MEX-file provided by Real-Time
Workshop. You can override this default by supplying appropriate files. See
“Creating an External Mode Communication Channel” in the Real-Time
Workshop documentation for details if you need to support other transport
layers.

The MEX-file arguments field lets you specify arguments, such as a
TCP/IP server port number, to be passed to the external interface program.
Note that these arguments are specific to the external interface you are
using. For information on setting these arguments, see “MEX-File Optional
Arguments for TCP/IP Transport” and “MEX-File Optional Arguments for
Serial Transport” in the Real-Time Workshop documentation.

This tutorial uses the default arguments. Leave the MEX-file arguments
field blank.

12 Click Apply to save the Interface settings.

13 Save the model.
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14 Click Real-Time Workshop in the center pane of the Model Explorer.
On the right, make sure that Generate code only is cleared, then click
the Build button to generate code and create the target program. The
content of subsequent messages depends on your compiler and operating
system. The final message is

### Successful completion of Real-Time Workshop
build procedure for model: extmode_example

In the next section, you will run the extmode_example executable and use
Simulink as an interactive front end to the running target program.

Running the External Mode Target Program

The target executable, extmode example, is now in your working directory.
In this section, you run the target program and establish communication
between Simulink and the target.

Note An external-mode program like extmode_example is a host-based
executable. Its execution is not tied to RTOS or a periodic timer interrupt, and
it does not run in real time. The program just runs as fast as possible, and
the time units it counts off are simulated time units that do not correspond to
time in the world outside the program.

The External Signal & Triggering dialog box (accessed via the External
Mode Control Panel) displays a list of all the blocks in your model that
support external mode signal monitoring and logging. The dialog box also lets
you configure the signals that are viewed and how they are acquired and
displayed. You can use it to reconfigure signals while the target program runs.
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In this tutorial, you observe and use the default settings of the External
Signal & Triggering dialog box.

1 From the Tools menu of the block diagram, select External Mode
Control Panel, which lets you configure signal monitoring and data
archiving. It also lets you connect to the target program and start and stop
execution of the model code.

=) example: External Mode Control Panel o ] 5

Connection and triggering

Connect Start Real-Tine Corde Arrn Trigoer

Flosting scope
[V Enable data uploading

Duration W

Patameter tuning

[ Batch download

Downlosad |

Configuration

Sighal & Triggering .. | Diata Archiving .. |

Close |

The top three buttons are for use after the target program has started. The
two lower buttons open separate dialog boxes:

¢ The Signal & triggering button opens the External Signal &
Triggering dialog box. This dialog box lets you select the signals that
are collected from the target system and viewed in external mode. It also
lets you select a signal that triggers uploading of data when certain
signal conditions are met, and define the triggering conditions.

¢ The Data archiving button opens the External Data Archiving
dialog box. Data archiving lets you save data sets generated by the target
program for future analysis. This example does not use data archiving.
See “Data Archiving” in the Real-Time Workshop documentation for
more information.

2 In the External Mode Control Panel, click the Signal & Triggering
button. The External Signal & Triggering dialog box opens. The
default configuration of the External Signal & Triggering dialog box is
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designed to ensure that all signals are selected for monitoring. The default
configuration also ensures that signal monitoring will begin as soon as the
host and target programs have connected. The figure below shows the
default configuration for extmode example.

<} extmode_example: External Signal & Triggering s ]
Signal selection
Block Path
X Scope A extuode_exanple/Scope A d W Select all
X Scope B extuode_exanple/Scope B Clear all
Coon
e off
Trigger signal
ﬂ Gofo blosk
Trigger
Source: |menual  +| Mode: Innrmal - | | Triveer signsl Port: |1 Element. [ory
B
Duration: [1000 Delay: o =
R rm when cannect to tar.. Direction: [rising -] Lever o Hoid-oft. [
Revartl Help | App\yl Close |

3 Make sure that the External Signal & Triggering dialog box is set to
the defaults as shown:

¢ Select all check box is selected. All signals in the Signal selection list
are marked with an X in the Block column.

* Trigger Source: manual

¢ Trigger Mode: normal

¢ Duration: 1000

¢ Delay: 0

e Arm when connect to target: selected

Click Close, and then close the External Mode Control Panel.

For information on the options mentioned above, see “External Signal
Uploading and Triggering” in the Real-Time Workshop documentation.
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4 To run the target program, you must open a command prompt window
(on UNIX systems, an Xterm window). At the command prompt, change
to the ext_mode example directory that you created in step 1. The target
program is in this directory.

cd ext_mode_example

Next, type the following command:

extmode_example -tf inf -w

and press Return.

Note On Windows platforms, you can also use the “bang” command (!)
in the MATLAB Command Window (note that the trailing ampersand is
required): !extmode_ example -tf inf -w &

The target program begins execution. Note that the target program is in a
wait state, so no activity occurs in the MATLAB Command Window.

The -tf switch overrides the stop time set for the model in Simulink. The
inf value directs the model to run indefinitely. The model code runs until
the target program receives a stop message from Simulink.

The -w switch instructs the target program to enter a wait state until it
receives a Start real-time code message from the host. This switch is
required if you want to view data from time step O of the target program
execution, or if you want to modify parameters before the target program
begins execution of model code.

5 Open Scope blocks A and B. At this point, no signals are visible on the
scopes. When you connect Simulink to the target program and begin model
execution, the signals generated by the target program will be visible on
the scope displays.

6 The model itself must be in external mode before communication between
the model and the target program can begin. To enable external mode,
select External from the simulation mode pulldown menu located on the
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right side of the toolbar of the Simulink window. Alternatively, you can
select External from the Simulation menu.

7 Reopen the External Mode Control Panel (found in the Tools menu)
and click Connect. This initiates a handshake between Simulink and the
target program. When Simulink and the target are connected, the Start
Real-Time Code button becomes enabled, and the label of the Connect
button changes to Disconnect.

8 Click the Start Real-Time Code button. The outputs of Gain blocks A and
B are displayed on the two scopes in your model. With A = 2 and B = 3,
the output looks like this:

~10]x| I -10) x]
lam|lcrpp ABE O |lemlreo /BB B

Having established communication between Simulink and the running target
program, you can tune block parameters in Simulink and observe the effects
the parameter changes have on the target program. You do this in the next
section.

Tuning Parameters

You can change the gain factor of either Gain block by assigning a new value
to the variable A or B in the MATLAB workspace. When you change block
parameter values in the workspace during a simulation, you must explicitly
update the block diagram with these changes. When the block diagram is
updated, the new values are downloaded to the target program.
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To tune the variables A and B,

1 In the MATLAB Command Window, assign new values to both variables,

for example:

2 Activate the extmode_example model window. Select Update Diagram
from the Edit menu, or press Ctrl+D. As soon as Simulink has updated
the block parameters, the new gain values are downloaded to the target
program, and the effect of the gain change becomes visible on the scopes.

3 You can also enter gain values directly into the Gain blocks. To do this,
open the Block Parameters dialog box for Gain block A or B in the model.
Enter a new numerical value for the gain and click Apply. As soon as
you click Apply, the new value is downloaded to the target program and
the effect of the gain change becomes visible on the scope. Similarly, you
can change the frequency, amplitude, or phase of the sine wave signal by
opening the Block Parameters dialog box for the Sine Wave block and
entering a new numerical value in the appropriate field.

Note that because the Sine Wave is a source block, Simulink pauses while
the Block Parameters dialog box is open. You must close the dialog box
by clicking OK, which allows Simulink to continue and enable you to see
the effect of your changes.

Also note that you cannot change the sample time of the Sine Wave block.
Block sample times are part of the structural definition of the model and
are part of the generated code. Therefore, if you want to change a block
sample time, you must stop the external mode simulation, reset the block’s
sample time, and rebuild the executable.

To simultaneously disconnect host/target communication and end execution
of the target program, pull down the Simulation menu and select Stop
Real-Time Code. You can also do this from the External Mode Control
Panel.
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Generating Code for a Referenced Model

e “Tutorial Overview” on page 3-50

® “Creating and Configuring a Subsystem Within the vdp Model” on page 3-50
® “Converting the Model to Use Model Referencing” on page 3-53

® “Generating Model Reference Code for a GRT Target” on page 3-57

* “Working with Project Directories” on page 3-60

Tutorial Overview

The Model block allows an existing Simulink model to be used as a block in
another model. When a model contains one or more Model blocks, it is called
a parent model. Models represented by Model blocks are called referenced
models in that context.

Model blocks are particularly useful for large-scale modeling applications.
They work by generating code and creating a binary file for each referenced
model, then executing the binary during simulation. Real-Time Workshop
generates code for referenced models in a slightly different way than for top
models and stand-alone models, and generates different code than Simulink
does when it simulates them. Follow this tutorial to learn how Simulink and
Real-Time Workshop handle Model blocks.

In this tutorial, you create a subsystem in an existing model, convert it to a
referenced model, call it from the top model via a Model block, and generate
code for both models. You accomplish some of these tasks automatically with
a function called Simulink.Subsystem.convertToModelReference. You also
explore the generated code and the project directory using the Model Explorer.

Creating and Configuring a Subsystem Within the

vdp Model

In the first part of this tutorial, you define a subsystem for the vdp

demo model, set configuration parameters for the model, and use the
Simulink.Subsystem.convertToModelReference function to convert it into
two new models — the top model (vdptop) and a referenced model vdpmultRM
containing a subsystem you created (vdpmult):
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1 In MATLAB, create a new working directory wherever you want to work
and cd into it:

mkdir tutorial6
cd tutorial6

2 Open the vdp demo model by typing:

vdp

3 Drag a box around the three blocks on the left to select them, as shown
below:

van der Pol Equation

=1,

1-u*u
e
Fon
tlu

Y

w2

4 Choose Create Subsystem from the model’s Edit menu.
A subsystem block replaces the selected blocks.

5 If the new subsystem block is not where you want it, move it to a preferred
location.

6 Rename the block vdpmult.
7 Right-click the vdpmult block and select Subsystem Parameters.

The Function Block Parameters dialog box appears.
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8 In the Function Block Parameters dialog box, select Treat as atomic
unit, then click OK.

The border of the vdpmult subsystem thickens to indicate that it is now
atomic. An atomic subsystem executes as a unit relative to the parent
model: subsystem block execution does not interleave with parent block
execution. This property makes it possible to extract subsystems for use as
stand-alone models and as functions in generated code.

The block diagram should now appear as follows:

van der Pol Equation

{in1
Out1

Je{InZ

wdpmult l:l

>

Scope

w2 )
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You must set several properties before you can extract a subsystem for use as
a referenced model. To set the necessary properties,

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click Configuration (Active) in the left pane.

4 In the center pane, select Solver.
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5 In the right pane, under Solver Options change the Type to Fixed-step,
then click Apply. You must use fixed-step solvers when generating code,
although referenced models can use different solvers than top models.

6 In the center pane, select Optimization. In the right pane, under
Simulation and code generation, select Inline parameters. Click

Apply.
7 In the center pane, select Diagnostics. In the right pane:

a Select the Data Validity tab. In the Signals area, set Signal
resolution to Explicit only.

b Select the Connectivity tab. In the Buses area, set Mux blocks used
to create bus signals to error.

8 Click Apply.
The model now has the properties that model referencing requires.

9 In the center pane, click Model Referencing. In the right pane, set
Rebuild options to If any changes in known dependencies detected.
Click Apply. This setting prevents unnecessary code regeneration.

10 In the vdp model window, choose File > Save as. Save the model as vdptop
in your working directory. Leave the model open.

Converting the Model to Use Model Referencing

In this portion of the tutorial, you use the conversion function
Simulink.SubSystem.convertToModelReference to extract the subsystem
vdpmult from vdptop and convert vdpmult into a referenced model named
vdpmultRM. To see the complete syntax of the conversion function, type at
the MATLAB prompt:

help Simulink.SubSystem.convertToModelReference

For additional information, type:

doc Simulink.SubSystem.convertToModelReference
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If you want to see a demo of Simulink.SubSystem.convertToModelReference
before using it yourself, type:

sldemo_mdlref_conversion

Simulink also provides a menu command, Convert to Model Block, that
you can use to convert a subsystem to a referenced model. The command calls
Simulink.SubSystem.convertToModelReference with default arguments.
See “Converting Subsystems to Model References” in the Simulink
documentation.

Extracting the Subsystem to a Referenced Model

To use Simulink.SubSystem.convertToModelReference to extract vdpmult
and convert it to a referenced model, type:

Simulink.SubSystem.convertToModelReference...

('vdptop/vdpmult', 'vdpmultRM',...
'ReplaceSubsystem', true, 'BuildTarget', 'Sim')

This command:

1 Extracts the subsystem vdpmult from vdptop.

2 Converts the extracted subsystem to a separate model named vdpmultRM
and saves the model to the working directory.

3 In vdptop, replaces the extracted subsystem with a Model block that
references vdpmultRM.

4 Creates a simulation target for vdptop and vdpmultRM.

The converter prints a number of progress messages, and when successful,
terminates with

ans =
1
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The parent model vdptop now looks like this:

wvarn der Pol Equation

wdpmult l:l
>

Note the changes in the appearance of the block vdpmult. These changes
indicate that it is now a Model block rather than a subsystem. As a Model
block, it has no contents of its own: the previous contents now exist in the
referenced model vdpmultRM, whose name appears at the top of the Model
block. Widen the Model block as needed to expose the complete name of the
referenced model.

If the parent model vdptop had been closed at the time of conversion, the
converter would have opened it. Extracting a subsystem to a referenced model
does not automatically create or change a saved copy of the parent model. To
preserve the changes to the parent model, save vdptop.
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Right-click the Model block vdpmultRM and choose Open Model
’'vdpmultRM’ to open the referenced model. The model looks like this:

‘I
int X
F
Cutd
In2 hdu

Files Created and Changed by the Converter
The files in your working directory now consist of the following (not in this
order).

File Description

vdptop.mdl Top-level model that contains a Model block
where the vdpmult subsystem was

vdpmultRM.md1l Referenced model created for the vdpmult
subsystem

vdpmultRM_msf.mexw32 Static library file (Windows only). The
last three characters of the suffix are
system-dependent and may differ. This
file executes when the vdptop model calls
the model block vdpmult. When called,
vdpmult in turn calls the referenced model
vdpmultRM.

/slprj Project directory for generated model
reference code

Code for model reference simulation targets is placed in the slprj/sim
subdirectory. Generated code for GRT, ERT, and other Real-Time Workshop
targets is placed in slprj subdirectories named for those targets. You will
inspect some model reference code later in this tutorial. For more information
on project directories, see “Working with Project Directories” on page 3-60.
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Running the Converted Model

Open the Scope block in vdptop if it is not visible. In the vdptop window, click
the Start tool or choose Start from the Simulation menu. The model calls
the vdpmultRM_msf simulation target to simulate. The output looks like this:

Titne oftset. 0

Generating Model Reference Code for a GRT Target

The function Simulink.SubSystem.convertToModelReference created the
model and the simulation target files for the referenced model vdpmultRM. In
this part of the tutorial, you generate code for that model and the vdptop
model, and run the executable you create:

1 Verify that you are still working in the tutorial6 directory.
2 If the model vdptop is not open, open it. Make sure it is the active window.

3 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

4 In the Model Hierarchy pane, click the + sign preceding the vdptop
model to reveal its components.

5 Click Configuration (Active) in the left pane.

6 In the center pane, select Data Import/Export.
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7 Check Time and Output in the Save to workspace section of the right
pane, then click Apply. The pane shows the following information:

Data Import/E xport
—Load fram warkspac:
I~ Input I[t, u]

™ Initial state: |x|nitial

—Save to workspacs

v Time |t0ut
[~ States: Ixout
[w Outpuk I_uout

[™ Final states: |xFinaI
[w Signal logging: I\Ugsuut

[~ Inspect signal logs when simulation is paused/stopped

—Sawe option
I iLimt data poins (o ast: [1900 Decimation|’
Format: I Ariay vl

These settings instruct the model vdptop (and later its executable) to log
time and output data to MAT-files for each time step.

8 Generate GRT code (the default) and an executable for the top model and
the referenced model by selecting Real-Time Workshop in the center
pane and then clicking the Build button.

Real-Time Workshop generates and compiles code. The current directory now
contains a new file and a new directory:

File Description

vdptop.exe The executable created by Real-Time
Workshop

vdptop_grt_rtw/ The Real-Time Workshop build
directory, containing generated code
for the top model

Real-Time Workshop also generated GRT code for the referenced model, and
placed it in the slprj directory.
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To view a model’s generated code in Model Explorer, the model must
be open. To use the Model Explorer to inspect the newly created build
directory, vdptop_grt_rtw:

1 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

2 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

3 Click the + sign preceding Code for vdptop to reveal its components.
4 Click This Model that appears directly under Code for vdptop.

A list of generated code files for vdptop_converted appears in the
Contents pane:

rtmodel.h
vdptop.c
vdptop.h
vdptop.mk
vdptop_private.h
vdptop_types.h

You can browse code in any of these files by selecting a file of interest in
the Contents pane. The code for the file you select appears in the pane
to the right. The figure below illustrates viewing code for vdptop.c. Your
code may differ.
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To open a file in a text editor, click a filename, and then click the hyperlink
that appears in the gray area at the top of the Document pane.

Working with Project Directories

When you view generated code in Model Explorer, the files listed in the

Contents pane can exist either in a build directory or a project directory.

Model reference project directories (always rooted under slprj), like build
directories, are created in your current working directory, and this implies
certain constraints on when and where model reference targets are built,

and how they are accessed.

The models referenced by Model blocks can be stored anywhere. A given top
model can include models stored on different file systems and directories. The
same is not true for the simulation targets derived from these models; under
most circumstances, all models referenced by a given top model must be set
up to simulate and generate model reference target code in a single project
directory. The top and referenced models can exist anywhere on your path,
but the project directory is assumed to exist in your current directory.

This means that, if you reference the same model from several top models,
each stored in a different directory, you must either

¢ Always work in the same directory and be sure that the models are on
your path
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¢ Allow separate project directories, simulation targets, and Real-Time
Workshop targets to be generated in each directory in which you work

The files in such multiple project directories are generally quite redundant.
Therefore, to avoid regenerating code for referenced models more times than
necessary, you might want to choose a specific working directory and remain
in it for all sessions.

As model reference code generated for Real-Time Workshop targets as well as
for simulation targets is placed in project directories, the same considerations
as above apply even if you are generating target applications only. That is,
code for all models referenced from a given model ends up being generated in
the same project directory, even if it is generated for different targets and at
different times.
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Documenting a Code Generation Project

e “Tutorial Overview” on page 3-62

® “Generating Code for the Model” on page 3-64

® “Opening Report Generator” on page 3-65

e “Setting Report Output Options” on page 3-67

® “Specifying Models and Subsystems to Include in a Report” on page 3-68
e “Setting Component Options” on page 3-68

® “Generating the Report” on page 3-69

e “Reviewing the Generated Report” on page 3-69

Tutorial Overview

As explained in “Documenting the Project” on page 2-14, one way of
documenting a Real-Time Workshop code generation project is to use the
Report Generator for MATLAB and Simulink. In this tutorial, you adjust
Report Generator settings to include custom code and then generate a report
for the Real-Time Workshop demo rtwdemo_f14. A summary of the steps
for the tutorial follows:

1 Generate code for the model.

2 Open Report Generator.

3 Set report output options.

4 Specify models and subsystems to be included.
5 Set component options.

6 Generate the report.

7 Review the generated report.
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Note You need a license for Simulink Report Generator to complete steps
3 through 5. If you omit those steps and use the default option settings, the
resulting output will vary from what is documented in step 6.

For details on using Report Generator, see the MATLAB Report Generator
documentation.
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Generating Code for the Model

Before you can use Report Generator to document your project, you must
generate code for the model. To generate code for the rtwdemo_f14 demo,

1 In MATLAB, navigate to a directory where you have write access.
2 Create a working directory from the MATLAB command line by typing:

mkdir report_ex

3 Make report_ex your working directory:

cd report_ex

4 Open the rtwdemo_f14 model by clicking the model name below or by
entering the model name on the MATLAB command line.

rtwdemo_f14

The model appears in a Simulink model window.

5 In the model window, choose File > Save As, navigate to the working
directory, report_ex, and save a copy of the rtwdemo_f14 model as
myf14.mdl.

6 Open Model Explorer by selecting Model Explorer from the model’s
View menu.

7 In the Model Hierarchy pane, click the + sign preceding the model name
to reveal its components.

8 Click Configuration (Active) in the left pane.

9 In the Contents pane, click Real-Time Workshop. The Real-Time
Workshop General pane appears.

10 Deselect Generate HTML report and Launch report automatically in
the Documentation section. Select Generate code only and click Apply.

11 Click Generate code. Real-Time Workshop generates code for the model.
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Opening Report Generator
After you generate the code, open the Report Generator.

1 In the model window, select Tools > Report Generator. The Report
Explorer window opens.

H report Explorer -|o] x|
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For alternative ways of opening the Report Generator, see “How MATLAB
and Simulink Interact with Report Generator” in the MATLAB Report
Generator documentation.

2 In the options pane (center), find the folder rtw (\toolbox\rtw) and the
setup file that it contains — codegen.rpt.

L T '
f/’ databazetlbx.pt
3o tbw [skoolboshbe] -eeeeees
I~ - ptgendemos [Moolbossrptgen] -
2% chil-utorial it
f/’ figloop-tutorial ipt
P
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3 Double-click codegen.rpt or select it and click the Open report button

EI. Report Generator displays the structure of the setup file in the
outline pane (left).

erport Explorer - Report - codegen.rpt
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Setting Report Output Options

Before generating a report, you can specify report output options, such as the
directory, file name, and format. The following steps explain how to generate
a Microsoft Word report named MyCGModelReport.rtf.

1 Review the options listed under Report Options in the properties pane.

@ Report Explorer - Report - codegenrpt®
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[ tW 4 mXR] % e
1 Report Dptions
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w1 P Chagher - Germnbed oo
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Divesciony | Presert wodking deectoy ] [

Flename [ Same 1 1ehi fle =] fdest

I B impucnt shmaschy wasihs, ircimenend o prvend avwresiing

Fgoont Fearnal ared Stylechmet

il Bt | et THTML] =] | Dot HTML spachest

2

Gerration Options

¥ Wiew irgnt aftes geresabion
T Audes e Easdion grrmatn
Evausle B shang after genersion [

Pepont descrption
FestTime Wobahop Code Generstion Repon =

Thiz sepon documens code genesshed by Rleal Time Wodkshep

Thre e e et ke snagshots of the model and i subaysteis. the biock, emmcadion s, |

EERGS P ESEESERNS. FRSERESEL

Forlocp
Lol £ By defauk Repos ot ] e - |
Loged Dliad
Logicalf end can sk specily & moded in the “Modsl option” pare n the “Modsl Loog” comgonent =
Logeal Then . il_l
B Wi Lo |

P — B I R T

2 Leave the Directory field set to Present working directory.

3 Select Custom: for Filename and replace index with the name
MyModelCGReport.

4 For File format, specify Rich Text Format and replace Standard Print
with Numbered Chapters & Sections.
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5 In the outline pane (left), click Report - codegen.rpt*. The following
acknowledgment dialog box appears.

& Report Explorer - Report - s e |

Y'ou have made changes ta the embedded dialog.
Apply changes?

it

QK I lgnore Cancel

6 Click OK.

Specifying Models and Subsystems to Include in a

Report
Specify the models and subsystems to be included in the generated report by

setting options in the Model Loop component.

1 In the outline pane (left), select Model Loop. Report Generator displays
Model Loop component options in the properties pane.

2 If not already selected, select Current block diagram for the Model
name option.

3 In the outline pane, click Report - codegen.rpt*. If you modified the
value of the Model name option, the change acknowledgment dialog box
appears. If the dialog box appears, click OK.

Setting Component Options
After setting the report output options, review and, if appropriate, adjust
Real-Time Workshop component options.

1 In the outline pane (left), expand the node Chapter - Generated Code.
By default, the report includes two sections, each containing one of two

Real-Time Workshop report components.

2 Expand the node Section 1 — Code Generation Summary. The Code
Generation Summary component appears.
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3 Select Code Generation Summary. Options for the component appear in
the properties pane.

4 Click Help to review the report customizations you can make with the
Code Generation Summary component. For this tutorial, do not customize
the component.

5 Return focus to the Report Explorer window and expand the node Section
1 — Generated Code Listing. The Import Generated Code component
appears.

6 Select Import Generated Code. Options for the component appear in
the properties pane.

7 Click Help to review the report customizations you can make with the
Import Generated Code component.

8 Return focus to the Report Explorer window.

Generating the Report

After you adjust report options, from the Report Explorer window, generate
the report by clicking File > Report. A Message List dialog box appears,
which displays messages you can monitor as the report is generated. Model
snapshots also appear during report generation.

For alternative ways of generating reports, see “How MATLAB and
Simulink Interact with Report Generator” in the MATLAB Report Generator
documentation.

Reviewing the Generated Report
Review your generated report. Make sure the following information is

included:

¢ System snapshots (model and subsystem diagrams)

® Block execution order list

¢ Version information for generated code — model and Real-Time Workshop

e List of generated files
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® Optimization configuration parameter settings

® Real-Time Workshop target selection and build process configuration
parameter settings

® Subsystem map
¢ File name, path, and generated code listings for the following:
= myfid.c
= rt_nonfinite.c
= myfi4.h
= myfi14_private.h
= myfi14_types.h
= rt_nonfinite.h
= rtmodel.h
= rtwtypes.h
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application modules
With respect to Real-Time Workshop program architecture, these are
collections of programs that implement functions carried out by the
system-dependent, system-independent, and application components.

atomic subsystem
Subsystem whose blocks are executed as a unit before moving on.
Conditionally executed subsystems are atomic, and atomic subsystems
are nonvirtual. Unconditionally executed subsystems are virtual by
default, but can be designated as atomic. Real-Time Workshop can
generate reusable code only for nonvirtual subsystems.

base sample rate
Fundamental sample time of a model; in practice, limited by the fastest
rate at which a processor’s timer can generate interrupts. All sample
times must be integer multiples of the base rate.

block 1/0O structure (model_B)
Global data structure for storing block output signals. The number
of block output signals is the sum of the widths of the data output
ports of all nonvirtual blocks in your model. By default, Simulink and
Real-Time Workshop try to reduce the size of the model_ B structure by
reusing the entries in the model B structure and making other entries
local variables.

block target file
File that describes how a specific Simulink block is to be transformed to
a language such as C, based on the block’s description in the Real-Time
Workshop file (model . rtw). Typically, there is one block target file for
each Simulink block.

code reuse
Optimization whereby code generated for identical nonvirtual
subsystems is collapsed into one function that is called for each
subsystem instance with appropriate parameters. Code reuse, along
with expression folding, can dramatically reduce the amount of
generated code.

Glossary-1



Glossary

Glossary-2

configuration

Set of attributes for a model which defines parameters governing how a
model simulates and generates code. A model can have one or more such
configuration sets, and users can switch between them to change code
generation targets or to modify the behavior of models in other ways.

configuration component

Named element of a configuration set. Configuration components
encapsulate settings associated with the Solver, Data Import/Export,
Optimization, Diagnostics, Hardware Implementation, Model
Referencing, and Real-Time Workshop panes in the Configuration
Parameters dialog box. A component may contain subcomponents.

embedded real-time (ERT) target

Target configuration that generates model code for execution on an
independent embedded real-time system. Requires Real-Time Workshop
Embedded Coder.

expression folding

Code optimization technique that minimizes the computation of
intermediate results at block outputs and the storage of such results
in temporary buffers or variables. It can dramatically improve the
efficiency of generated code, achieving results that compare favorably
with hand-optimized code.

file extensions

The table below lists the file extensions associated with Simulink, the
Target Language Compiler, and Real-Time Workshop.

Extension Created by Description
.c or .cpp Target Language The generated C or
Compiler C++ code
.h Target Language C/C++ include header
Compiler file used by the .c or
.Cpp program
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Extension

Created by

Description

.mdl

Simulink

Contains structures
associated with
Simulink block

diagrams

.mk

Real-Time Workshop

Makefile specific to
your model that is
derived from the
template makefile

.rtw

Real-Time Workshop

Intermediate
compilation
(model.rtw) of a
.md1 file used in
generating C or C++
code

.tlc

The MathWorks and
Real-Time Workshop
users

Target Language
Compiler script
files that Real-Time
Workshop uses to
generate code for
targets and blocks

.tmf

Supplied with
Real-Time Workshop

Template makefiles

L tmw

Real-Time Workshop

Project marker

file inside a build
directory that
identifies the date
and product version
of generated code

generic real-time (GRT) target
Target configuration that generates model code for a real-time system,
with the resulting code executed on your workstation. (Execution is
not tied to a real-time clock.) You can use GRT as a starting point for
targeting custom hardware.
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host system
Computer system on which you create and may compile your real-time
application. Also referred to as emulation hardware.

inline
Generally, this means to place something directly in the generated
source code. You can inline parameters and S-functions using Real-Time
Workshop and the Target Language Compiler.

inlined parameters
(Target Language Compiler Boolean global variable: InlineParameters)
The numerical values of the block parameters are hard-coded into the
generated code. Advantages include faster execution and less memory
use, but you lose the ability to change the block parameter values at
run time.

inlined S-function
An S-function can be inlined into the generated code by implementing it
as a .tlc file. The code for this S-function is placed in the generated
model code itself. In contrast, noninlined S-functions require a function
call to an S-function residing in an external MEX-file.

interrupt service routine (ISR)
Piece of code that your processor executes when an external event, such
as a timer, occurs.

loop rolling
(Target Language Compiler global variable: Rol1Threshold) Depending
on the block’s operation and the width of the input/output ports, the
generated code uses a for statement (rolled code) instead of repeating
identical lines of code (flat code) over the signal width.

make
Utility to maintain, update, and regenerate related programs and files.
The commands to be executed are placed in a makefile.

makefiles
Files that contain a collection of commands that allow groups of
programs, object files, libraries, and so on, to interact. Makefiles are
executed by your development system’s make utility.
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model.ritw
Intermediate record file into which Real-Time Workshop compiles the
blocks, signals, states, and parameters a model, which the Target
Language Compiler reads to generate code to represent the model.

multitasking
Process by which a microprocessor schedules the handling of multiple
tasks. In generated code, the number of tasks is equal to the number of
sample times in your model. See also pseudo multitasking.

noninlined S-function
In the context of Real-Time Workshop, this is any C-MEX S-function
that is not implemented using a customized .tlc file. If you create
a C-MEX S-function as part of a Simulink model, it is by default
noninlined unless you write your own . tlc file that inlines it.

nonreal-time
Simulation environment of a block diagram provided for high-speed
simulation of your model. Execution is not tied to a real-time clock.

nonvirtual block
Any block that performs some algorithm, such as a Gain block.
Real-Time Workshop generates code for all nonvirtual blocks, either
inline or as separate functions and files, as directed by users.

pseudo multitasking
On processors that do not offer multitasking support, you can perform
pseudo multitasking by scheduling events on a fixed time-sharing basis.

real-time model data structure
Real-Time Workshop encapsulates information about the root model
in the real-time model data structure, often abbreviated as rtM. rtM
contains global information related to timing, solvers, and logging, and
model data such as inputs, outputs, states, and parameters.

real-time system
Computer that processes real-world events as they happen, under the
constraint of a real-time clock, and that can implement algorithms in
dedicated hardware. Examples include mobile telephones, test and
measurement devices, and avionic and automotive control systems.
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Real-Time Workshop target
Set of code files generated by Real-Time Workshop for a standard
or custom target, specified by a Real-Time Workshop configuration
component. These source files can be built into an executable program
that will run independently of Simulink. See also simulation target,
configuration.

run-time interface
Wrapper around the generated code that can be built into a stand-alone
executable. The run-time interface consists of routines to move the time
forward, save logged variables at the appropriate time steps, and so on
The run-time interface is responsible for managing the execution of the
real-time program created from your Simulink block diagram.

S-function
Customized Simulink block written in C, Fortran, or M-code. Real-Time
Workshop can target C-code S-functions as is or users can inline C-code
S-functions by preparing TLC scripts for them.

simstruct
Simulink data structure and associated application program interface
(API) that enables S-functions to communicate with other entities
in models. Simstructs are included in code generated by Real-Time
Workshop for noninlined S-functions.

simulation target
Set of code files generated for a model which is referenced by a Model
block. Simulation target code is generated into /slprj/sim project
directory in the working directory. Also an executable library compiled
from these codes that implements a Model block. See also Real-Time
Workshop target.

single-tasking
Mode in which a model runs in one task, regardless of the number of
sample rates it contains.

stiffness
Property of a problem that forces a numerical method, in one or more
intervals of integration, to use a step length that is excessively small in
relation to the smoothness of the exact solution in that interval.
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system target file
Entry point to the Target Language Compiler program, used to
transform the Real-Time Workshop file into target-specific code.

target file
File that is compiled and executed by the Target Language Compiler.
The block and system target TLC files used specify how to transform
the Real-Time Workshop file (model.rtw) into target-specific code.

Target Language Compiler (TLC)
Program that compiles and executes system and target files by
translating a model.rtw file into a target language by means of TLC
scripts and template makefiles.

Target Language Compiler program
One or more TLC script files that describe how to convert a model . rtw
file into generated code. There is one TLC file for the target, plus one
for each built-in block. Users can provide their own TLC files to inline
S-functions or to wrap existing user code.

target system
Specific or generic computer system on which your real-time application
is intended to execute. Also referred to as embedded hardware.

targeting
Process of creating software modules appropriate for execution on your
target system.

task identifier (tid)
In generated code, each sample rate in a multirate model is assigned a
task identifier (tid). The tid is used by the model output and update
routines to control the portion of your model that should execute at
a given time step. Single-rate systems ignore the tid. See also base
sample rate.

template makefile
Line-for-line makefile used by a make utility. Real-Time Workshop
converts the template makefile to a makefile by copying the contents
of the template makefile (usually system.tmf) to a makefile (usually
system.mk) replacing tokens describing your model’s configuration.
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virtual block
Connection or graphical block, for example a Mux block, that has no
algorithmic functionality. Virtual blocks incur no real-time overhead
as no code is generated for them.

work vector
Data structures for saving internal states or similar information,
accessible to blocks that may require such work areas. These include
state work (rtDWork), real work (rtRWork), integer work (rtIWork), and
pointer work (rtPWork) structures. For example, the Memory block uses
a real work element for each signal.
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acceleration of development process 1-7
application requirements 2-3

block target file 2-21

build directory
contents of 2-29
naming convention 2-28
rtwdemo_f14 example 3-12
seeing files 3-12

build directory optional contents
C-API files 2-29
HTML report files 2-29
model.rtw 2-29
object files 2-29
subsystem code modules 2-29
TLC profiler files 2-29

build process
files and directories created 2-23
messages in MATLAB Command

Window 3-11

steps in 2-18

C

code generation for Simulink models 1-5
Code Generation Summary component 3-68
code generation tutorial 3-27
product support for 1-17
code verification tutorial 3-21
code with buffer optimization 3-33
efficiency 3-33
code with expression folding 3-34
code without buffer optimization 3-30
comments options 3-10

compilers
Borland 1-13
Intel 1-13

LCC 1-14
list of supported 1-12
MEX 1-12
Microsoft Visual C/C++ 1-14
optimization settings 1-12
Watcom 1-15

configuration parameters 2-8
factory defaults 2-5
impacts of settings 2-5
questions to consider 2-4

D

data logging 3-14
from generated code 3-23
tutorial 3-14
via Scope blocks
example 3-21
debug options 3-9
debugging
and configuration parameter settings 2-5
dialog boxes
Block Parameters 3-39
Configuration Parameters 2-4
External Mode Control Panel 3-45
External Signal and Triggering 3-45
Model Explorer 2-8
directories
build 3-4
working 3-4
documentation 3-62
online 1-19

efficiency

and configuration parameter settings 2-5
executable

running 3-11
extensible make process 1-7
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extensive model debugging support 1-5
external mode

F

building executable 3-41
control panel 3-45
definition of 1-4

model setup 3-39
parameter tuning 3-48
running executable 3-44
tutorial 3-38

files

generated. See generated files

fixed-step solver 3-5

G

generated files 2-23
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model (UNIX executable) 2-25
model.c 2-24

model_capi.c 2-27
model_capi.h 2-27
model_data.c 2-25
model_dt.h 2-27

model.exe (PC executable) 2-25
model.h 2-24

model.mdl 2-23

model.mk 2-26
model_private.h 2-24
model.rtw 2-24
model_targ_data_map.m 2-27
model_target_rtw 2-28
model_types.h 2-25
modelsources.txt 2-27
rt_nonfinite.c 2-26
rt_nonfinite.h 2-26
rt_sfcn_helper.c, 2-28
rt_sfcn_helper.h 2-28
rtmodel.h 2-26

rtw_proj.tmw 2-26
rtwtypes.h 2-26
subsystem.c 2-27
subsystem.h 2-27

generic real-time (GRT) target
tutorial 3-4

Import Generated Code component 3-69
integration
Real-Time Workshop with Simulink 1-6
Real-Time Workshop with Stateflow 1-6

L

large-scale modeling 1-4

M

make process 1-4
make utility 2-16
makefile 2-21
MAT-files
creating 3-17
loading 3-24
MATLAB 1-2
MATLAB Report Generator
opening 3-65
setting component options for 3-68
setting report output options for 3-67
specifying models and subsystems with 3-68
model (on UNIX) 2-25
Model Advisor 2-9
model compiling process 2-20
Model Explorer
viewing code in 3-59
model referencing
converting to 3-53
definition of 3-50
generating code 3-57
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tutorial 3-50
model .bat 2-27
model.c 2-24
model_capi.c 2-27
model_capi.h 2-27
model_data.c 2-25
model_dt.h 2-27
model.h 2-24
model.mdl 2-23
model.mk 2-26
model_private.h 2-24
model.rtw 2-24
model_targ_data_map.m 2-27
model_target_rtw 2-28
model_types.h 2-25
modelsources.txt 2-27

o
optimizations

expression folding 3-34

signal storage reuse 3-32
out-of-environment error message 1-12

P

parameters

setting correctly 3-5
pilot G Force plot 3-16
project

documenting 3-62
project directory 2-28

working with 3-60

rapid simulations 1-4

Real-Time Workshop
capabilities and benefits 1-4
components and features 1-4
demos 1-16

extensible make process 1-7

features 1-7

installing 1-11

integration with Simulink 1-6

integration with Stateflow 1-6

model debugging support 1-5

products supported by 1-17

report 3-35

software development with 1-7

third-party compilers
configuration 1-13
support 1-12

typical workflow 2-2

Real-Time Workshop Report 3-35
Report Generator

opening 3-65
setting component options for 3-68
setting report output options for 3-67

specifying models and subsystems with 3-68

report output options 3-67
reports

generating code generation 3-62

rt_nonfinite.c 2-26
rt_nonfinite.h 2-26
rt_sfcn_helper.c 2-28
rt_sfcn_helper.h 2-28
rtmodel.h 2-26
rtw_proj.tmw 2-26

rtwdemo_f14 GRT code generation tutorial 3-4

rtwdemo_f14 model 3-3
rtwtypes.h 2-26
run-time interface modules 3-30

S

safety precautions

and configuration parameter settings 2-5

save to workspace options 3-15
Simulink 1-2
Simulink Report Generator
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opening 3-65
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setting report output options for 3-67
specifying models and subsystems with 3-68
slprj directory 2-28
Stateflow 1-6
subsystem.c 2-27
subsystem.h 2-27
subsystems
converting to referenced models 3-53
treating as atomic units 3-51
symbols options 3-9
system target file 2-20

T

target

how to specify 3-7

Real-Time Workshop support 1-6
target file

block 2-21

system 2-20
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Target Language Compiler
function library 2-20
generation of code by 2-20
TLC scripts 2-20
traceability
and configuration parameter settings 2-5
tuning parameters 3-48
tutorials
building generic real-time program 3-4
code generation 3-27
code verification 3-21
data logging 3-14
external mode 3-38
model referencing 3-50
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variable-step solver 3-5
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working directory 2-28
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